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Technical Support

If you have difficulties using IVM Answering Attendant please read the applicable topic before 
requesting support. If your problem is not covered in this user guide please view the up-to-date 
IVM Answering Attendant Online Technical Support at www.nch.com.au/ivm/support.html. 
If that does not solve your problem, you can contact us using the technical support contacts 
listed on that page.

Software Suggestions

If you have any suggestions for improvements to IVM Answering Attendant, or suggestions for 
other related software that you might need, please post it on our Suggestions page at 
www.nch.com.au/suggestions/index.html

. 
Many of our software projects have been undertaken after suggestions from users like you. 
You get a free upgrade if we follow your suggestion.

www.nch.com.au/ivm/support.html
www.nch.com.au/suggestions/index.html
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IVM Overview

IVM is a telephone voicemail, call attendant, and Interactive Voice Response (IVR) program 
that can connect to phone lines using a professional telephony board, voice modem, or directly 
to a VoIP service.

For example, IVM can play a menu to callers, redirect incoming calls during office hours or act 
as an answer machine and take messages for a number of voice mail boxes after hours. All 
calls (including those answered by you) are logged with date, time and caller ID. Recorded 
messages can be played at any time, forwarded to an email address, accessed via the internet 
or, if necessary, saved for future reference. All this makes IVM a complete solution for 
voicemail, call attendant, menu system, info-line, audiotext or autodial outbound calling.

Typical Applications 

● Voicemail (from a simple answering machine to hundreds of voice mailboxes).
● In-coming caller ID logger or display.
● Call attendant to transfer and direct phone calls.
● Telephone information lines or AudioText type systems.
● Automated telephone surveys (using the number entry features linked to a database).
● Credit card telephone account payment.
● Dial in computer control or information (e.g. Dial in to test security alarm or to restart 

server).
● Automated outbound call systems.

Features 

● Caller ID logging
● Key press menus and ability for caller to enter numbers.
● Unlimited voice mail boxes (each with own email forward, internet access page or remote 

access).
● Call transfer (subject to your phone company or PBX features).
● Remote Access (listen to messages by dialing-in).
● Automatic hours feature (enter office hours to automatically answer after hours).
● Call simulator to test your systems off-line.
● Automated Outbound Calls to play telephone messages to a list of numbers.
● Text-to-Speech voice synthesis as an alternative to recording or importing audio files.
● Ability to open files or run other software to process data or report information.
● Free professionally voiced greetings included.

System Requirements 

● Windows 2000/XP/2003/Vista and Windows 7.
● Pentium 100 or above with at least 32MB RAM (higher requirements apply for multiple line 

installations).
● Hardware Lines: TAPI compliant (100%) telephony device. This includes most voice 

modems or a professional telephony card (e.g. CallURL).
●  VoIP Lines: Any SIP RFC3261 compliant sip service or the Axon Virtual VoIP PBX. 
● [Optional] Internet Access [to forward by email or VoIP lines]
● [Optional] Website (on local or remote server) [for Internet Access Pages]
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Caution: If you intend to use IVM with a voice modem, please note that there are many voice 
modems on the market with defective TAPI wave / voice drivers. Please install the software 
and check your modem works before you rely on it. If it does not work properly, check 
Telephony Hardware (TAPI and driver issues)

 for some possible solutions. 

Registration & Purchase Requirements 

If you want to use IVM after you have tested it, you must purchase a license (register) for each 
installation of IVM. For more information, please see: Purchasing and Registering IVM. 
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General Concepts

Out-Going Messages (OGMs) 

Out-Going Messages or "OGMs" are central to the way IVM works. Each OGM is a node along 
the call flow, and the call state at any time is centered on what the current OGM is. The 
information set in the OGM Properties determines how the call proceeds.

Out-Going Messages are so named because the majority will play a message to the caller, but 
you can have OGMs with no associated audio.

When IVM is used as a simple answering machine, only one OGM is needed which will be the 
"Thank you for calling... please leave a message after the tone". The Properties of that OGM 
will be set with the active command "Leave Message for Mailbox... Default" at the message 
end (after the audio has played).

More sophisticated interactive voice response systems might have hundreds of OGMs all 
chained together with menus and other active commands (see IVR programs below or 
active commands

 for more information). 

Each OGM can have different menus, messages and other properties. If you are creating a 
complex setup with many OGMs, you will find the OGM List to be the central point when 
setting up the system. From the OGM List you can also view the useful OGM Report which lists 
all the menus in logical order. 

Don't confuse OGMs with Personal Mailbox Greetings. While they are both messages and can 
sometimes do the same thing, Mailbox Personal Greetings cannot have any interactivity 
attached to them and are linked directly to a single Mailbox.

For more information about OGMs see the following topics:

●  Out-Going Messages List  
●  Load/Save IVR Files 
●  OGM Properties 
●  Key Response Options 
●  Active Commands  
●  Transferring Calls 

Interactive Voice Response (IVR) Programs  

An Interactive Voice Response (IVR) Program is the system of all the OGMs chained together.

Some example IVR Programs have been included with IVM. The example IVR Programs can 
be a useful demonstration when setting up your IVR system but you will still need to read this 
manual so you can follow the example and modify it for your requirements. To load one of the 
example IVR programs select "Load New IVR Profile" on the "IVR Profile" tab of the web 
interface.

6

activecommand.html
ivrlist.html
ivrlist.html
ivrloadsave.html
ogmproperties.html
keyresponse.html
activecommand.html
transfer.html


For more information see Introduction to IVR Systems. 

Voice Mailboxes and In-Coming Messages 

When the caller leaves an In-Coming Message it is usually recorded into a Voice Mailbox. The 
Mailbox Properties

 determine how and where the message will be sent or accessed. 
Messages can be forwarded as attachments to an email, accessed using an Internet Browser 
(Web Access), uploaded to a FTP server, copied to a folder on the network, forwarded to a 
telephone number (outward dial) or accessed remotely by phone by dialing in to IVM and 
entering an access code. 

Usually, you would setup one Mailbox for every person in your office who would be receiving 
IVM messages. There should also always be the "Default" Mailbox which is used when no 
Mailbox is specified.

A Mailbox can also have a personal greeting that will be played immediately before the 
message is recorded only if the active command is set to play the personal greeting. In a single 
Mailbox setup you would not use this (the OGM would be the greeting), but with multiple 
Mailboxes you might want to use a personal greeting for each Mailbox.

For more information about Mailboxes see Mailbox Properties. 

Voice over IP (VoIP) 

Voice over IP means that instead of connecting to a real phone line you connect though a 
'virtual' phone line to a voice over IP server through your broadband connection.

This technology means you can get a free number to receive and make free Internet phone 
calls (from and to Internet calls) and for a fee even have an ordinary phone number which is 
routed to your computer through the Internet. If you need a dedicated phone line for IVM you 
will find VoIP numbers usually are much cheaper than having a real line connected. And you 
don't need any telephony hardware.

For outbound automated calls depending on the gateway you select you will find calls made 
via VoIP are dirt cheap compared to the cost of phone calls made on an ordinary phone line.

IVM uses the most popular "SIP" protocol for VoIP calls. We fully support the standards 
RFC3261(SIP), RFC3515(REFER), RFC3891(Replaces) and RFC2833(DTMF).

See www.nch.com.au/talk/sip.html for a list of recommended SIP Providers. If this is your first 
time with VoIP we also recommend you download the free Express Talk VoIP Softphone which 
is like a telephone in your computer. 
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Quick Start Guides

I want to use IVM for: 

●  As an Answering Machine  
●  As a office Voice Mail System (1 - 10000 voicemail boxes)  
●  For Automated Outbound Calls  
●  Connect IVM with Axon (virtual pbx) 
●  Connect with a virtual PBX other than Axon 
●  Connecting to a traditional analog PBX 
●  Designing Complex IVR Programs 
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Introduction to IVR Systems

An Interactive Voice Response (IVR) system is the string of all OGMs chained together making 
different call flows that can follow these chains.

To create a more advanced interactive voice response setup, you will need to use 
Key Response Menus

 and Active Commands  to chain multiple OGMs together. You will work 
primarily from the Out-Going Messages List , found on the "IVR Profile" tab of the web 
interface, to create and manage all of the needed OGMs. 

From the OGM List you can also view an OGM Report which lists all the menus in logical order 
which can be useful while working on the ivr or call flow design.

You do not need to know any programming languages or to write any scripts to create a 
system with menus and data entry. If you read the next few sections of this manual carefully, 
you should be able to setup your system as required.

To help you test IVR system call flow you can use the Call Simulator . It can also be helpful to 
refer to the System Logs  to help you see what is happening as you go through the OGMs. 
When designing an IVR system we recommend you take small steps at a time and frequently 
test the changes along the way. If the IVM behaves one way on the Call Simulator and a 
different way on real calls then that is normally an indication of a modem compatibility issue. 

Some example IVR Programs are included with IVM and can be loaded from the "Load New 
IVR Profile" window which is accessed from the "IVR Profile" tab on the web interface. The 
example IVR Programs can be a useful demonstration when setting up your IVR system but 
you will still need to read this manual so you can follow the example and modify it for your 
requirements.

See also:

Key Response Options 

Active Commands  

Out-Going Messages List  

ISO/IEC13714 (standard for IVR menu structures) 
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Troubleshooting Problems

IVM does not answer calls 

1. Is IVM in [ON] Mode? Click on the [ON] button on the top right of the IVM Main Window so 
that it displays red.

2.  Is your voice modem or telephony device listed in the line devices list on the Devices tab 
of in Settings? If you are unable to add the device, please see 
Telephony Hardware (TAPI and driver issues)

. 
3. Turn AutoHours off in Settings.
4. Check your OGM using OGM Properties. Can you play the message? Turn off all Date and 

CID Validity Checking and untick the Play External Wav File option.
5. Is some other software using the modem or telephony line device? Are you currently 

connected to the Internet using that line?
6. If you are attempting to use a modem, is it a true voice modem?

If none of the above solves your problem, please see 
Telephony Hardware (TAPI and driver issues)

 for hardware related tips. 

IVM answers the call but does not play a message  

1. If you are attempting to use a modem, is your modem a true voice modem?
2. If you are attempting to use a Dialogic Telephony Card, have you installed the Wave 

drivers (in addition to the TAPI drivers)?
3. Check the OGM (Out-Going Message) Properties under the IVR Profiles tab.

If none of the above solves your problem, please see 
Telephony Hardware (TAPI and driver issues)

 for hardware related tips. 

Call hangs-up mid message or during recording 

This can happen when the hardware is misdetecting the end-of-call tone during playback or 
recording. If it happens during playback, turn off the "Enable end-of-tone detection during 
playback" option using the "Advanced Line Settings" from the Devices tab of Settings. If it only 
happens during recording, turn on the "Enable end-of-tone detection during playback" option 
but turn off the "Enable software based end-of-call detection" option.

Recording does not stop when the caller hangs-up  
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If you have end-of-call tones on your line check you have turned on the "Enable end-of-tone 
detection during playback" option using the "End of Call Tone Detection Settings" from the 
Devices tab of Settings.

If your line has silence at the end of calls increase the Record Detect Level a little.

Transfer Problems 

IVM cannot directly transfer between VoIP and conventional telephone lines. To do this there 
needs to be some form of VoIP to PSTN gateway, such as a FXO Adapter or a 
VoIP gateway provider

. 

Sometimes IVM dials too quickly for the PBX or your phone company. In that case you may 
need to insert a pause (',') or longer pauses (',,,') using commas after the flash character ('!') 
and after the dialed digits.

Another possible problem with transfers that use a hook flash is that different countries and 
different phone systems can require different flash times. Check your PBX flash time or ask 
your telephone company (if you are not using a PBX).

● For professional telephony cards, you can usually set the flash time in the hardware 
settings. Enter the device properties from the "Telephony Lines" tab on the web application.

● For voice modems you can add the Extra Setting S29=X where X is the flash time in tenths 
of a second. Add the S29=1 setting to the "Extra Settings" for the modem (Settings / 
Devices / Properties / Configure / Connection / Advanced).

How to place a caller "on-hold" 

In the previous example you might want to place the caller "on-hold". You could have a 
response such as "* - go to 'OGM on-hold' ". The on-hold OGM will play a suitable .wav file 
(and repeat it if necessary). There would be an escape response in this OGM (e.g. to return to 
the previous OGM or to be transferred).

How to Pick-up Call using Same Line (pseudo-transfer) 

(1) Create an OGM (the "Hold OGM") with an message of say "please hold the line" then say 3 
minutes of "hold" music". (2) Under the Key Response tab of the Hold OGM's Properties have: 
Press '#' - Hang-up (immediate). (3) Under the Advanced tab of the Hold OGM's Properties, 
tick the "announce call through speakers" option and browse to find a suitable wav file (ideally 
this could say... "Call for ..."). (4) Under the Key Response tab of the Main OGM's Properties 
have Press 1 - "Go to OGM... Hold OGM". When a caller presses 1, you will hear the account 
file (e.g. "Call for Jay") through your speakers while the caller hears hold music. To 'take' the 
call simply pick up the phone and press #.
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The audio quality is poor 

The audio quality is determined by the modem. Some voice modems offer only very poor 
quality voice. If audio quality is important, you should consider purchasing a professional 
telephony card. See Telephony Hardware for suitable cards. 

IVM includes a playback gain device, playback tone control and playback dynamic range 
compressor which can be used to improve audio quality. See Line Playback Settings for more 
information. 

How to Make it Louder/Softer on the Telephone 

You can change the Volume Level under the System Settings in the web application. (Note the 
actual change is limited by your telephony device).

Caller ID is not displayed or displays "Unknown" 

1. Your voice modems might not support caller ID (not all do). Check your modem manual.
2. You need to set IVM to answer after at least 2 rings.
3. Your phone system may not have caller ID (sometimes you need to pay for the feature).
4. If you are using a PBX extension, your PBX might not support caller ID.

Email forward of messages fails 

1. Have you entered your ISP SMTP mailhost server using the Email Settings button on 
Mailbox Properties?

2. If you receive an error message when attempting to send mail with SMTP your server may 
require authentication (i.e. username and password) to send email. Use the format 
smtp.yourmailhost.com:username:password for the mailhost.

If none of the above solves your problem, please view the up-to-date IVM Online Technical 
Support at www.nch.com.au/ivm/support.html. If that does not solve your problem, you can 
contact us using the technical support contacts listed on that page. 
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Purchasing, License and Registration

You must purchase a license (register) to use this version of IVM if you want to continue to use 
some it after the trial period of 14 days.

You can choose between a number of license classes depending on the maximum number of 
lines, OGMs, and Voice Mailboxes require or whether Outbound Calls are required. Please 
refer to the following table.

License Class  Lines  OGMs   Mailboxes  Outbound Calls  
 Basic Answering 
Machine 

1 1 1 No

 Small Business 2 3 30 No
 Small Interactive 
System 

2 70 8 Yes

 Professional  3 70 30 Yes
 Enterprise  64 unlimited unlimited Yes
 
You can view current pricing and purchase a license online at www.nch.com.au/ivm/register. 

Once you have obtained your registration information, use the menu File -> Register Software 
and enter your registration details exactly as provided. Once you have registered the software 
you must backup the IVM folders in case your hard drive fails. (We do not keep copies of 
registrations or old software versions). 

IVM License Terms 

1. The copyrights in this software and any audio or visual work distributed with the software 
belong to NCH Software. NCH Software reserves all rights. NCH Software licenses the 
distribution and installation of this software only in accordance with these terms.

2. By installing, using or distributing this software you, on your own behalf and on behalf of 
your employer or principal, agree to be bound by these terms. If you do not agree to any of 
these terms, you may not use, copy, transmit, distribute, or install this software.

3. This software, and all accompanying files, data and materials, are distributed "as is" and 
with no warranties of any kind, whether express or implied except as required by law. If you 
intend to rely on this software for critical purposes, it is essential that you should test it fully 
prior to using it for critical applications and you must assume the entire risk of using the 
program.

4. NCH Software will not be liable for any loss arising out of the use of this software including, 
but not limited to, any special, incidental or consequential loss. NCH Software may not 
refund any amount paid for the purchase of the software to the purchaser of the software 
unless the purchaser satisfies NCH Software that they tested the free version of the 
software prior to purchase.

5. You may not use this software in any circumstances where there is any risk that failure of 
this software might result in a physical injury or loss of life. Any such use by you is entirely 
at your own risk, and you agree to indemnify NCH Software from any claims relating to 
such unauthorized use.

13

http://nch.com.au/ivm/register/index.html


6. You may copy or distribute the installation file of this software in its complete unaltered 
form but you may not, under any circumstances, distribute any software registration code. 
In the event that you do distribute a software registration code, you will be liable to pay the 
full purchase price for each location where the unauthorized use of code occurs.

7. This software is free for evaluation use only. To use the software for professional purposes, 
you must purchase (register) a license for each location (address) where the software will 
be used.

8. The contract arising out of this agreement is governed by the laws and courts of the 
Australian Capital Territory.
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Connecting with Skype

Skype now allows business users to connect SIP devices and programs directly to a special 
Skype Account called a Skype Connect account. These accounts work a lot like regular Skype 
accounts, but must be setup through a different interface called Skype Manager. For a detailed 
explanation of how to set up a Skype Connect account and configure it for use with IVM, see 
Skype for SIP configuration

. 
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Software License Terms

1.  The copyrights in this software and any visual or audio work distributed with the software 
belong to NCH Software and others listed in the about box. All rights are reserved. 
Installation of this software and any software bundled with or installed-on-demand from this 
software is licensed only in accordance with these terms.

2.  By installing, using or distributing this software you, on your own behalf and on behalf of 
your employer or principal, agree to be bound by these terms. If you do not agree to any of 
these terms, you may not use, copy, transmit, distribute, nor install this software - return it 
to the place of purchase within 14 days to receive a full refund.

3.  This software, and all accompanying files, data and materials, are distributed "as is" and 
with no warranties of any kind, whether express or implied except as required by law. If you 
intend to rely on this software for critical purposes you must test it fully prior to using it, 
install redundant systems and assume any risk.

4.  We will not be liable for any loss arising out of the use of this software including, but not 
limited to, any special, incidental or consequential loss. Your entire remedy against us for 
all claims is limited to receiving a full refund for the amount you paid for the software.

5.  You may not use this software in any circumstances where there is any risk that failure of 
this software might result in a physical injury or loss of life. You agree to indemnify us from 
any claims relating to such unauthorized use.

6.  You may copy or distribute the installation file of this software in its complete unaltered 
form but you may not, under any circumstances, distribute any software registration code 
for any of our programs without written permission. In the event that you do distribute a 
software registration code, you will be liable to pay the full purchase price for each location 
where the unauthorized use occurs.

7.  Use of statistics collected by the software is subject to the NCH Software Privacy 
Statement which allows automatic anonymized collection of usage statistics in limited 
circumstances.

8.  The contract arising out of this agreement is governed by the laws and courts of the 
Australian Capital Territory.
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 Quick Start Guides - Answering Machine

If you have already completed the Setup Wizard to set up an answering machine skip ahead to 
step 6 to customize your configuration.

Step 1: Run the Setup Wizard

If the Setup Wizard is not open, you can start it by choosing the "Run Setup Wizard..." option 
under the File menu. 

Step 2: Select "Answering Machine (no PBX)" 

Step 3: Configure Telephone Line(s)

On this page you will need to add any telephone lines that you want IVM to be able to answer. 

●  Hardware - all of the compatible hardware that IVM detects on your machine will be listed. 
Select the name of the hardware device that you wish to add and press the "Add Line..." 
button below the list to configure the device.

See Hardware/Device line properties for more information on configuration options.

If your hardware does not appear on the list please see the Hardware Troubleshooting page
. 

●  VoIP - if you already have a VoIP account that you would like to connect to select the 
"New SIP based VoIP Account..." option and press "Add Line..." button below the list to 
configure the account.

See VoIP Line Properties for more information on configuration options. 

If you have Axon installed you may see an additional setup page asking which Axon lines you 
would like to ring on IVM. Select the lines that you will be using for your IVM installation so that 
these will connect to IVM correctly. 

Step 4: Configure Mailbox(es)

Select the number of mailboxes that you want to have. If you select one mailbox IVM will go 
straight to the mailbox when it answers a call. If you have multiple mailboxes the caller will be 
asked to enter an extension for the mailbox they wish to leave a message in, the mailbox 
numbers will start at one and go up to zero for a total of up to ten mailboxes.

If you would like to be able to access your messages through a web browser select the 
"Enable mailboxes to be accessed via a network and Web browser" 

Step 5: Complete Wizard 

Step 6: Changing your Voicemail Greeting(s)

Double click on the voice mailbox you want to change the greeting for. This will open the 
General Mailbox Properties
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. If you selected a single mailbox it will be named 'voicemail,' if you selected multiple mailboxes 
the will be numbered starting from '1' up to '10'.

Step 7: Test your system with call simulator

Use the Call Simulator  to test. 

See also:

General Mailbox Properties  

VoIP Line Properties 

Hardware/Device line properties 
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 Quick Start Guides - VoiceMail System

If you have already completed the Setup Wizard to set up a voicemail system skip ahead to 
step 6 to customize your configuration.

Step 1: Run the Setup Wizard

If the Setup Wizard is not open, you can start it by choosing the "Run Setup Wizard..." option 
under the File menu. 

Step 2: Select "Voicemail (with PBX)" 

Step 3: Configure Telephone Line(s)

On this page you will need to add any telephone lines that you want IVM to be able to answer. 

●  Hardware - all of the compatible hardware that IVM detects on your machine will be listed. 
Select the name of the hardware device that you wish to add and press the "Add Line..." 
button below the list to configure the device.

See Hardware/Device line properties for more information on configuration options.

If your hardware does not appear on the list please see the Hardware Troubleshooting page
. 

●  VoIP - if you already have a VoIP account that you would like to connect to select the 
"New SIP based VoIP Account..." option and press "Add Line..." button below the list to 
configure the account.

See VoIP Line Properties for more information on configuration options. 

If you have Axon installed you may see an additional setup page asking which Axon lines you 
would like to ring on IVM. Select the lines that you will be using for your IVM installation so that 
these will connect to IVM correctly. 

Step 4: Configure Mailbox(es)

If you have Axon on you computer you can choose to have IVM create a mailbox for each of 
your Axon extensions. These mailboxes will be named with the corresponding extension 
names.

If you would prefer to create numbered mailboxes without importing them from Axon select the 
"I would like to create mailboxes without using Axon's extension list and enter the number of 
mailboxes you would like to create. The mailbox numbers will start at '101'.

If you would like to be able to access your messages through a web browser select the 
"Enable mailboxes to be accessed via a network and Web browser." checkbox.

If you would like to require users to enter a PIN number to access their voice messages, select 
the "Require a PIN number to access mailboxes when dialing in." checkbox. 

19

hardwarelineproperties.html
http://www.nch.com.au/kb/10045.html
voiplineproperties.html


Step 5: Complete Wizard 

Step 6: Changing your Voicemail Greeting(s)

Double click on the voice mailbox you want to change the greeting for. This will open the 
General Mailbox Properties

. If you selected a single mailbox it will be named 'voicemail,' if you 
selected multiple mailboxes the will be numbered starting from '1' up to '10'.

Step 7: Test your system with call simulator

Use the Call Simulator  to test. 

See also: Connect IVM with Axon (virtual pbx)

Connect with a virtual PBX other than Axon

Connecting to a traditional analog PBX

VoIP Line Properties

Hardware/Device line properties

Key Response

Complex IVR Systems
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 Quick Start Guides - Automated Call Attendant

If you have already completed the Setup Wizard to set up an automated call attendant skip 
ahead to step 6 to customize your configuration.

Step 1: Run the Setup Wizard

If the Setup Wizard is not open, you can start it by choosing the "Run Setup Wizard..." option 
under the File menu. 

Step 2: Select "Automated Call Attendant (with PBX)" 

Step 3: Configure Telephone Line(s)

On this page you will need to add any telephone lines that you want IVM to be able to answer. 

●  Hardware - all of the compatible hardware that IVM detects on your machine will be listed. 
Select the name of the hardware device that you wish to add and press the "Add Line..." 
button below the list to configure the device.

See Hardware/Device line properties for more information on configuration options.

If your hardware does not appear on the list please see the Hardware Troubleshooting page
. 

●  VoIP - if you already have a VoIP account that you would like to connect to select the 
"New SIP based VoIP Account..." option and press "Add Line..." button below the list to 
configure the account.

See VoIP Line Properties for more information on configuration options. 

If you have Axon installed you may see an additional setup page asking which Axon lines you 
would like to ring on IVM. Select the lines that you will be using for your IVM installation so that 
these will connect to IVM correctly. 

Step 4: Install Example IVR(s)

Some example IVRs are provided to help demonstrate how to set up IVM for various 
situations. Click on the links below for more information about the example programs that are 
available:

●  Real Estate Property Line 
●  Sending A Fax 
●  Sample Survey 
●  Account Payment with Credit Card  

These examples should be treated as a starting point only, providing you with a basic setup 
that you will still need to modify these to meet your specific requirements. Exploring the set up 
of these examples may also be a good way to help familiarize yourself with IVM even if in the 
end you plan to set up an entirely different IVR program.

21

hardwarelineproperties.html
http://www.nch.com.au/kb/10045.html
voiplineproperties.html
samplerealestate.html
samplefax.html
samplesurvey.html
samplecreditcard.html


Step 5: Complete Wizard 

Step 6: Changing your Outgoing Messages (OGMs)

You can create a single OGM to play an audio message, or set up a long call flow that will be 
started when a call is answered. An example of a longer call flow would be the 
Sample IVR Survey

 that you can load from the included example files provided with IVM. If you are creating 
a longer OGM Call Flow be sure to use the Call Simulator  to test along the way. You may also 
want to see Complex IVR Systems when creating your ivr profile. 

Step 7: Test your system with call simulator

Use the Call Simulator  to test. 

See also: Connect IVM with Axon (virtual pbx)

Connect with a virtual PBX other than Axon

Connecting to a traditional analog PBX

VoIP Line Properties

Hardware/Device line properties

Key Response

Complex IVR Systems

22

samplesurvey.html
uicallsimulator.html
qs-ivr.html
uicallsimulator.html
qs-pbxaxon.html
qs-pbxvirtual.html
qs-pbxanalog.html
voiplineproperties.html
hardwarelineproperties.html
keyresponse.html
qs-ivr.html


 Quick Start Guides - Information Line

If you have already completed the Setup Wizard to set up an information line skip ahead to 
step 5 to customize your configuration.

Step 1: Run the Setup Wizard

If the Setup Wizard is not open, you can start it by choosing the "Run Setup Wizard..." option 
under the File menu. 

Step 2: Select "Information Line" 

Step 3: Configure Telephone Line(s)

On this page you will need to add any telephone lines that you want IVM to be able to answer. 

●  Hardware - all of the compatible hardware that IVM detects on your machine will be listed. 
Select the name of the hardware device that you wish to add and press the "Add Line..." 
button below the list to configure the device.

See Hardware/Device line properties for more information on configuration options.

If your hardware does not appear on the list please see the Hardware Troubleshooting page
. 

●  VoIP - if you already have a VoIP account that you would like to connect to select the 
"New SIP based VoIP Account..." option and press "Add Line..." button below the list to 
configure the account.

See VoIP Line Properties for more information on configuration options. 

If you have Axon installed you may see an additional setup page asking which Axon lines you 
would like to ring on IVM. Select the lines that you will be using for your IVM installation so that 
these will connect to IVM correctly. 

Step 4: Complete Wizard 

Step 5: Test your system with call simulator

Use the Call Simulator  to test. For more information on the information line usage, see 
Real Estate Property Line

. 

See also: VoIP Line Properties

Hardware/Device line properties
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 Quick Start Guides - Automated Outbound Calling

If you have already completed the Setup Wizard to set up a outbound system skip ahead to 
step 6 to customize your configuration.

Step 1: Run the Setup Wizard

If the Setup Wizard is not open, you can start it by choosing the "Run Setup Wizard..." option 
under the File menu. 

Step 2: Select "Automated Outbound Dialing" 

Step 3: Configure Telephone Line(s)

On this page you will need to add any telephone lines that you want IVM to be able to answer. 

●  Hardware - all of the compatible hardware that IVM detects on your machine will be listed. 
Select the name of the hardware device that you wish to add and press the "Add Line..." 
button below the list to configure the device.

See Hardware/Device line properties for more information on configuration options.

If your hardware does not appear on the list please see the Hardware Troubleshooting page
. 

●  VoIP - if you already have a VoIP account that you would like to connect to select the 
"New SIP based VoIP Account..." option and press "Add Line..." button below the list to 
configure the account.

See VoIP Line Properties for more information on configuration options. 

If you have Axon installed you may see an additional setup page asking which Axon lines you 
would like to ring on IVM. Select the lines that you will be using for your IVM installation so that 
these will connect to IVM correctly. 

Step 4: Install Example IVR(s)

Some example IVRs are provided to help demonstrate how to set up IVM for various 
situations. Click on the links below for more information about the example programs that are 
available for outbound dialing:

●  Sample Survey 

These examples should be treated as a starting point only, providing you with a basic setup 
that you will still need to modify these to meet your specific requirements. Exploring the set up 
of these examples may also be a good way to help familiarize yourself with IVM even if in the 
end you plan to set up an entirely different IVR program.

Step 5: Complete Wizard 

Step 6: Changing your Outgoing Messages (OGMs)
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You can create a single OGM to play an audio message, or set up a long call flow that will be 
started when a call is answered. An example of a longer call flow would be the 
Sample IVR Survey

 that you can load from the included example files provided with IVM. If you are creating 
a longer OGM Call Flow be sure to use the Call Simulator  to test along the way. You may also 
want to see Complex IVR Systems when creating your ivr profile. 

Step 7: Test your system with call simulator

Use the Call Simulator  to test. 

Step 8: Set Outbound Dialing Options

Go to the "Auto Dial" Tab of the Web Console to setup the outbound dialing. Here you can 
enter the list of phone numbers that will be called (For testing you might consider listing your 
own telephone number several times). You can choose a different OGM based on whether 
there is no answer, a person or an answer machine that is picked up. The Answering machine 
detection settings are set below the list, and should not be counted on as being one hundred 
percent accurate. Read more about these settings under Automated Outbound Calls and 
Answer Detection Settings

. 

Step 9: Turn Outbound Dialing On

When you are ready to start the outbound dialer, select the "Run Outbound Dialing" check box 
at the bottom of the Auto Dial window before pressing "Save Changes." Re Entering the "Auto 
Dial" tab will turn off the dialing so you don't change setting to a running auto dial campaign. 

See also: 

Automated Outbound Calls

Answer Detection Settings 
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 Quick Start Guides - Connecting IVM with Axon

Running IVM and Axon on the same machine 

If you are going to use both Axon and IVM on the same machine, we recommend that you 
setup Axon first, then install and set-up IVM. The setup wizard for IVM will check to see if Axon 
is running on your machine, and if it is found will give you the option to automatically setup a 
voice mailbox for every extension on Axon.

When using IVM in conjunction with Axon, IVM may be configured to handle Call Attendant 
actions on line 198 and voicemail access on line 199. That is, when an extension dials 199 that 
extension is immediately directed to their own Voice mailbox, and the first waiting Voicemail, if 
any, is played for them. Axon will direct Call Attendant through to line 198. The default 
message on this Call Attendant will direct the user that they should setup their own message 
and menu system.

Running IVM and Axon on separate machine 

If Axon will be running on another computer you will need to setup IVM manually to make use 
of Axon.

Two VoIP Accounts will also be pre-defined, VoIP Call Attendant (line 198) and VoIP Voicemail 
(line 199).

Add two new VoIP accounts for the Call Attendant and Voicemail using the following account 
details. See Voice over IP (VoIP) Line Properties for more information on creating a VoIP line. 

The first account

VoIP Account Name = 'VoIP Call Attendant'

Number of simultaneous lines allowed = 5

Full 'Friendly' Display Name = 'VoIP Call Attendant'

Sip Number (or User Name) = '198'

Server (Proxy and Domain) is set to the network address of the computer on which Axon is 
running

Password is set to the same password that line 198 is as defined in Axon

Answer OGM option set to 'Override Out-Going Message for this Line' and 'VoIP Call 
Attendant Start' is selected from the pull-down selection. 

The second account
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VoIP Account Name = 'VoIP Voicemail'

Number of simultaneous lines allowed = 5

Full 'Friendly' Display Name = 'VoIP Voicemail'

Sip Number (or User Name) = '199'

Server (Proxy and Domain) is set to the network address of the computer on which Axon is 
running

Password is set to the same password that line 199 is as defined in Axon

Answer OGM option set to 'Override Out-Going Message for this Line' and 'VoIP Voicemail 
Start' is selected from the pull-down selection. 
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 Quick Start Guides - Connecting with a virtual PBX 
other than Axon

Connecting IVM with a virtual PBX other than Axon 

Using IVM with another virtual PBX should be very similar to 
setting up IVM to work with Axon on another computer

, however you will want to familiarize yourself with your PBX. One place 
where there is likely to be a difference is in the voicemail extension, Axon will automatically 
forward unanswered calls to extension 199 for voicemail, the extension number dialed by other 
PBXs may be different, so be sure to note those possible differences when adjusting the 
settings as described in Connecting IVM with Axon. You will still be manually setting up two 
VoIP lines for the call attendant and voicemail. 
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 Quick Start Guides - Connecting to a traditional 
analog PBX

Connecting to a hardware PBX system 

IVM is often installed in an environment where there is telephone system or PBX. Broadly the 
types of usage are for voice mail (recording messages for unattended phones), call attendant 
(playing a menu and directing calls accordingly) or other interactive voice response systems.

For professional setups you need to know your PBX well. If you don't know your PBX and what 
it can do read the manual or call in the supplier. The information that follows is intended for 
more telephone-technical people.

One requirement that applies in all circumstances is that the calls for IVM be directed to analog 
ports . IVM will almost always be running on a computer that has a professional telephony card 
(see http://nch.com.au/ivm/modems.html for a list of recommended telephony boards and 
voice modems). These boards all have analog RJ12 style sockets. The first step is to ensure 
you have analog ports wired from your PBX. 

The next step is to program your PBX to direct the calls as required to those ports.

Voice Mail 

In an office IVM needs to decide who the call was for (and which mailbox to use). In a very 
simple setup the IVM could play a menu and let the caller select. But normally the PBX can 
send the intended extension to IVM.

Most PBXs can be programmed to send a DTMF dial string (inbound signaling) when the IVM 
picks up the call. This string of digits is dialed within a short time after answering. You need to 
find the format of this string in the PBX manual.

Once you know the format of the dial string:

1. Under the Key Response section of the OGM Properties select "Data-Entry".
2. In the maximum digits field enter the number of digits the PBX will send.
3. Tick the "Allow # in data entry" field.
4. Tick the "Use special digits mapping function".
5. Click Settings button next to it. In the box next to "Advanced parsing dial string" enter the 

dial string in the form XXXX111XXX where 1 corresponds to the intended extension 
number digits and X are digits to be ignored. In the box to the left of 1 enter mailboxno (all 
one word all lower case).

6. On the Message tab of OGM Properties next to "Then" select 'Leave Message for Mailbox' 
and type: MailBox%mailboxno%

If your PBX redirects a call meant for extension 123 it will leave it in MailBox123. You can 
change the settings of the "Default" mailbox if required.

On some PBXs you can also dial a string to turn off or on a message waiting light. To do this, 
use the "Mailbox Message Notification" options of MailBox properties.

AutoAttendant - (Menu + Transfer) 
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For auto-attendant and transferring calls the most important thing is that your PBX allows you 
to transfer calls with a 'hook flash' dial sequence. Check the manual and then see 
Transferring Calls

 for how to setup for call transfer. 

The biggest source of problems is the hook flash time (there is no international standard and 
different PBXs use different times). If IVM takes too long the PBX thinks it has hung up. If it is 
too short nothing is transferred. Check the flash time for your PBX, and the driver settings for 
your telephony card. They must match.
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 Quick Start Guides - Complex IVR Systems

Before you start, we strongly recommend that you read the IVM General Concepts, and 
Introduction to IVR Systems

 in this help manual to help familiarize yourself with some of the 
terminology and ideas that you will need when designing your Interactive Voice Response 
system. 

If you have already completed the Setup Wizard to set up a complex IVR system skip ahead to 
step 6 to customize your configuration.

Step 1: Run the Setup Wizard

If the Setup Wizard is not open, you can start it by choosing the "Run Setup Wizard..." option 
under the File menu. 

Step 2: Select "Other (Complex IVR System)" 

Step 3: Configure Telephone Line(s)

On this page you will need to add any telephone lines that you want IVM to be able to answer. 

●  Hardware - all of the compatible hardware that IVM detects on your machine will be listed. 
Select the name of the hardware device that you wish to add and press the "Add Line..." 
button below the list to configure the device.

See Hardware/Device line properties for more information on configuration options.

If your hardware does not appear on the list please see the Hardware Troubleshooting page
. 

●  VoIP - if you already have a VoIP account that you would like to connect to select the 
"New SIP based VoIP Account..." option and press "Add Line..." button below the list to 
configure the account.

See VoIP Line Properties for more information on configuration options. 

If you have Axon installed you may see an additional setup page asking which Axon lines you 
would like to ring on IVM. Select the lines that you will be using for your IVM installation so that 
these will connect to IVM correctly. 

Step 4: Install Example IVR(s)

Some example IVRs are provided to help demonstrate how to set up IVM for various 
situations. Click on the links below for more information about the example programs that are 
available:

●  Real Estate Property Line 
●  Sending A Fax 
●  Sample Survey 
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●  Account Payment with Credit Card  

These examples should be treated as a starting point only, providing you with a basic setup 
that you will still need to modify these to meet your specific requirements. Exploring the set up 
of these examples may also be a good way to help familiarize yourself with IVM even if in the 
end you plan to set up an entirely different IVR program.

Step 5: Complete Wizard 

Step 6: Changing your Outgoing Messages (OGMs)

You can create a single OGM to play an audio message, or set up a long call flow that will be 
started when a call is answered. An example of a longer call flow would be the 
Sample IVR Survey

 that you can load from the included example files provided with IVM. If you are creating 
a longer OGM Call Flow be sure to use the Call Simulator  to test along the way. You may also 
want to see Complex IVR Systems when creating your ivr profile. 

Step 7: Test your system with call simulator

Use the Call Simulator  to test. Make sure that you have correctly set your Start OGM to the 
correct entry point for your system. 

Designing a complex IVR System 

Before you do anything in IVM you need to make sure you have a plan for how people will 
progress through your system. This will help you plan how the OGM will link together and can 
help save you time in the long run when you start making the individual OGMs.

To create a more advanced interactive voice response setup, you will need to use 
Key Response Menus

 and Active Commands  to chain multiple OGMs together. You will work 
primarily from the Out-Going Messages List , found on the "IVR Profile" tab of the web 
interface, to create and manage all of the needed OGMs. 

Key Response 

For Each OGM that takes an input from the caller you have two options for accepting data. You 
can use the 'Single Key Press' mode, so that the caller simply hits the number of the option 
they want and are directed to the associated response. One drawback to this mode is that it 
limits the number of possible options. Alternatively you can instead use the 'Data Entry' mode 
which will let the system take a variable length input (usually followed by the # key). This opens 
possibilities for the number of options available but will also make it easier for an incorrect input 
to be entered, and you should be sure to consider how an incorrect input should be handled by 
your system. See Key Response Settings for more information. 

Active Commands  

Active Commands refers to all of the possible actions that IVM can perform after at the end of 
an OGM. Possible commands include, going to another OGM, Leaving a message for a 
mailbox, playing or recording an audio file, transferring to an extension, repeating an OGM, 
and ending the call. See Active Commands  for more information. 
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Plugins 

IVM Plugins can be used to process or obtain data. For example, if you are making a 
interactive voice response system to tell the caller the current temperature, a plugin can be 
used to read data from your hardware and return the temperature to IVM. A plugin could also 
be used to restart the computer, access a database, process credit card orders and more.

Visit www.nch.com.au/ivm/plugins.html for number of IVM plugins provided by NCH. More 
information on installing and using plugins can be found under Plugins. 

For programmer information about writing and creating plugins for IVM see the IVM Software 
Development Kit at www.nch.com.au/ivm/sdk.html. 

Be sure to regularly test your system along the way using the Call Simulator . 

See also:

IVM General Concepts 

Introduction to IVR Systems 

OGM Properties 

Key Response Settings 

Active Commands  

Transferring Calls 

Date-Time/CallerID Validity Checking  

Plugins 

Advanced OGM Options 
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General Settings - AutoHours

You can access and change the AutoHours Settings from both the Web Console on the 
"System Settings" Tab, as well as from the "AuToHours" tab on the application settings.

AutoHours Feature 

The IVM AutoHours schedule can be used to make IVM answer automatically only after 
business hours, to use different OGMs at different times of day or to change the number of 
rings to wait for at different times of day. This will save you having to manually turn IVM On/Off 
or select OGM every day.

To use AutoHours tick the "Use AutoHours" box and enter the applicable hours for weekdays, 
Saturday and Sunday. Then select what you want IVM to do between these hours and what 
you want IVM to do outside these hours.

Typical settings for a normal business offices are:

Weekdays: 09:00:00 to 17:00:00

Saturday: 09:00:00 to 12:00:00

Sunday: 00:00:00 to 00:00:00

Between these hours: Do not answer calls

After hours: Answer with default OGM

Similar results can be obtained using the Date-Time Validity Checking, but the system-wide 
AutoHours Settings are simpler. But if you are looking to setup a system that is more 
complex than the AutoHours feature allows you should see Date-Time Validity Checking. 
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General Settings - Call Transfer

You can access call transfer setting both from the Web Console under the "Answer Transfer 
Settings" found on the "System Settings" Tab, and in the application settings under the "Call 
Transfer" tab.

Transferring Calls 

Before changing these settings you must read the topic Transferring Calls to understand call 
transfer. 

Blind Transfer 

Enter the digits that IVM needs to dial to initiate a blind transfer (usually flash pause '!,') and 
any suffix needed to complete the call (not often required).

If your TAPI hardware can transfer calls using hardware, you can tick the "Use TAPI hardware 
box". Otherwise, leave this box unticked to make the transfer by simply dialing the digits.

Confirmed or Answer Detect Transfer 

Enter the digits that IVM needs to dial to initiate a confirmed or answer detect transfer (usually 
flash pause '!,'), the digits to dial if the call is accepted before hanging-up (usually nothing) and 
the number to dial if the call is rejected (usually another flash).

Simulate call transfers as a 3 party conference call 

If your telephone company or PBX does not support call transfers but does support a 
conference call, IVM can use this feature to "simulate" a transfer. When you tick the "Simulate 
call transfers as a conference call", IVM will run through the normal steps to setup a 
conference call (thinking it is transferring the call) and then stay online for the call duration. 
(Note: Your phone line will be busy for the call duration).

This option is usually only effective with confirmed transfers not blind transfers.
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General Settings - Voice Prompts

The Voice Prompt Settings can be found both from the Web Console under the "Voice 
Prompts" Tab and in the application settings under the "Prompts" tab. These tabs display a list 
of all the voice prompts that are used by IVM (e.g. reading a number back to a caller). From 
this list you can listen to or change any of the voice prompts.

To change a prompt, click on the 'Change' icon for the prompt you want to change, which will 
open the "change prompt" window. Here you can then choose to upload a new wav or mp3 file, 
synthesize text to speech, or restore the default file.

Advanced Option - multiple sets of prompts  

If you need two sets of prompts (for example one English and another French) create a copy of 
the System Prompts folder (C:\Documents and Settings\All Users\Application Data\NCH Swift 
Sound\IVM\System Prompts) somewhere else on your hard drive (e.g. C:\Documents and 
Settings\All Users\Application Data\NCH Swift Sound\IVM\French Prompts). Then at any point 
during the call to 'switch on' French call use the variable SystemPromptsFolder. In the 
Advanced tab of OGM Properties in the "Set local call variable" field enter 
"SystemPromptsFolder=C:\Documents and Settings\All Users\Application Data\NCH Swift 
Sound\IVM\French Prompts". 
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IVM Application Interface - General Settings

General Options 

Run IVM automatically 

IVM can be set to run automatically when the computer starts. To enable or disable this, tick or 
untick the "Run IVM automatically as tray icon on Startup" option. If you want to use IVM for a 
permanent telephone service, you should select this option.

There are many modes of running automatically which you can select in the pull down list.

To enable/disable the following functions perform the following steps.

1: Click on the "Settings" button listed at the top of the user interface.

2: Click on the "General" tab.

There are many modes of running automatically which you can select in the pull down list. 

If you want IVM to run always irrespective of whether anyone is logged on select one of the 
"Run As Service" options. When running as a service IVM will work before logon and after log 
off.

By default when running as a service IVM will 'show' and be accessible to all users as an icon 
on the tray of task bar. You can change this to limit it to the current user or no users. If you 
plan to use Windows Terminal or Remote Desktop you probably should restrict IVM to a local 
user or no users because 'showing' on a remote desktop can sometimes knock out local 
devices because they attempt to use the remote devices!

Running as a service only takes effect the next time you restart the PC. You should also check 
that it works after restarting your computer. If you have any problems check any folders are 
accessible from the "Local System" account.

Bring IVM to foreground when new message is received 

When this option is ticked, IVM will open to the foreground when a new message is received. 
This is useful if it is important that you know someone has left a message, but you may want to 
turn it off if you are working on your computer and do not want to be interrupted.

Answer Mode (Default Options) 

The answer mode settings can adjust the amount of time a caller will wait prior to the call being 
answered. These settings can be adjusted for the entire IVM system from the General Settings 
page of the Options dialog. They can also be overridden for specific lines. For more 
information on setting these options for a specific line see Telephony ~ Other. 

Answer calls after fixed number of rings (2 - 20) - This is the number of rings you would like a 
caller to hear before IVM answers. 

Use Tollsaver
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 - For answering machine implementations in IVM it may be desirable to have IVM ring longer 
when no new messages are waiting. By selecting this option IVM will ring an additional 2 rings 
before answering a call in that case. By default this will happen if there is a new message in 
any of the mailboxes in IVM. 

Only apply Tollsaver to a single mailbox  - If you prefer IVM can limit the Tollsaver to a single 
mailbox. You can have the mailbox automatically selected using the caller ID by selecting the 
"Use Caller ID" option. This will check for new messages in mailbox 101 for calls from 
extension 101. You can also pick a specific mailbox that is always checked for any calls 
coming in to IVM. 

Configure Default Email Settings  

This button opens the email settings for emails being sent to mailbox users with e-mail 
message delivery selected. See Email Settings for more information on these settings. 

Enable Speech Recognition in OGMs 

If you would like to use voice commands to control your IVR solution you will need to enable 
speech commands and select a speech recognition engine to use for recognizing the voice 
commands. After this is done you will also need to configure your OGMs by adding the 
appropriate voice command mapping information. For mor information on this see: 
Voice Commands

. 

If you do not have SAPI installed on your machine (or do not have a speech recognition 
installed) IVM will download a speech recognition for you. This is a fairly large component, but 
will only need to be downloaded once.
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IVM Application Interface - Telephony Settings

This is the list of all the telephone lines (PSTN and VoIP) currently configured for use.

This list should include all voice modems or professional telephony devices, as well as all of 
the VoIP lines that you wish to use, and all sip based lines that you may use to connect to 
other software programs, such as AXON or Express Talk.

Properties

To view the telephony line's properties, select the Line from the list and select "Properties..." 
from below the list. 

Add 

Below the list of telephony lines that have already been added to IVM, there is an "Add" option. 
Click "add" and then you will be able to choose to add a new VoIP Line or a new Hardware 
Line. See VoIP Line Properties and Hardware/Device line properties respectively for more 
information on the settings for each type of new telephony line. 

Note: You will only be able to add compatible hardware that IVM detects on your machine that 
has not already been added to the Telephony Lines list. See 
Telephony Hardware and Driver Issues (TAPI)

 or Troubleshooting  if you are having difficulty getting IVM to recognize your 
hardware. 

See also:

VoIP Line Properties 

Hardware/Device line properties 
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IVM Application Interface - Caller ID Settings

Caller ID Notification 

These options will notify you of the caller's number whenever a call is received by IVM. These 
notification are for the machine IVM is set up on only and will not notify other machines that 
may be connected with the call attendant features.

To use caller ID with normal telephone lines:

1. Voice modem/telephony card must support caller ID (not all do).
2. The phone company must send caller ID information (sometimes you need to pay your 

phone company for this feature).
3. If you are using a PBX extension, your PBX must carry the caller ID to the IVM extension.
4. You must answer after 2 rings (the caller ID information is carried between the first and 

second ring).

All VoIP systems support caller id.

Flash Caller ID of incoming call on screen 

When this option is ticked, IVM will display the caller number and name of any caller as a 
bubble on the tray of the task bar whenever the phone rings so you can know who is calling. It 
does this even when IVM is in Off mode.

Announce Caller Name through Speakers 

When this option is ticked, IVM will 'say' the caller number and name of any caller through the 
speakers whenever the phone rings so you can know who is calling. It does this even when 
IVM is in Off mode. The voice that is used for reading the caller's name and number can be 
selected from the drop down menu. If you don't see any voices in the pull down list it means 
you do not have a speech engine installed. You can download one of the text-to-speech 
engines using the links at www.nch.com.au/speech Also the Microsoft engine is free. 

Speak caller's number as digits 

Some speech engines may normally say the number as a whole number rather than list of 
digits, tick this option to force the caller's number to be said as a list of digits.

Caller Blocking 

When this option is ticked, IVM will treat some numbers differently based on caller ID. When a 
call comes in from a blocked ID IVM can either disconnect the call immediately or answer with 
a special OGM.

Block Numbers - You can enter a comma separated list of numbers to block here. 

Use CSV File - If you have a large number of different numbers to block or if you want to 
manage your block list from an external program you can have IVM read the list of blocked 
numbers from a CSV file. 

Block private or unknown numbers
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 - This option will block calls from unlisted, restricted and otherwise blocked or private 
numbers. 

41



IVM Application Interface - Audio Settings

Call Announce and Call Screening Device and Volume 

This is the device that IVM uses to screen calls, and announcing callers. Screening calls for a 
mailbox is set in the Mailbox Properties. Playing the call announcement or reading out the 
caller’s phone number as digits is turned on from the Caller ID Settings tab. 

Telephone Audio Play Process and Auto Gain Control 

These settings can be used to change the volume and help improve the quality of the audio 
being played to a caller and help to compensate for the low fidelity over phone lines or through 
your modem, however the quality of your hardware will ultimately determine the audio quality.

VoIP Quality 

The VoIP Quality settings apply to all VoIP calls made and received through IVM. By changing 
this setting IVM will attempt to use codecs with more or less compression (generally at the cost 
of CPU usage and audio quality).
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IVM Application Interface - Message Settings

Recording Messages 

From the "Audio" tab of the Application Settings you can set the minimum and maximum 
recording times for voicemail messages and other audio recording take by IVM such as a 
mailbox user calling in to change their voicemail greeting with remote telephone access, or any 
other key responses set to record a file in your OGMs. These settings can be overridden for 
individual mailboxes from within the Mailbox Properties, otherwise all incoming messages will 
be limited to meet these requirements. 

Record Detect Level 

This is for automatic voice activated recording and for end of call (silence) detection. If 
messages are not recorded fully, reduce this level (to say -36dB). If messages do not stop at 
the end of the call, increase this level (to say -15dB).

Delete Messages 

IVM automatically deletes in-coming messages after a set number of days. You can change 
the number of days using this setting. A value of 0 means the messages will never be 
automatically deleted.

Delivery Audio Compression Format 

Set the audio compression format for sending messages as attachments to an email address, 
or uploading to a FTP server or LAN (Local Area Network), you can use a number of different 
codecs to compress the audio (to reduce the file size and download time). Audio always 
records to the same format (telephone quality - 8kHz Mono) but prior to sending this codec will 
be applied

Play Device and Volume 

These settings are for the device and volume of voicemail messages listed to through the main 
window of the of the IVM application interface, or listening to the Default OGM also on the local 
machine from the main IVM window.
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IVM Application Interface - Web Access Settings

IVM supports web access which lets you log onto the IVM using any ordinary web browser 
over your network or even the Internet (if you set your firewall to allow it). After you log in with 
your a mailbox remote access code you check the messages for that mailbox remotely.

The settings for the web access can be found on the "Web Access" tab under the settings from 
the IVM application. To make sure that mailboxes have remote access enabled see 
Mailbox Properties

. 

To offer the web access control panel this software runs as a mini web server. It runs on port 
82 (the normal port is 80 but IVM does not use this in case you have another web server on 
the same computer).

To access your mailbox use one of the following address formats in your internet browser.

http://localhost:port if IVM is running on this 
computer

e.g. http://localhost:82
http://computername:port for use on a local computer 

network
e.g. http://mycomputer:82

http://computername:port for use on a local computer 
network

e.g. http://mycomputer:82
http://privateip:port for use on a local computer 

network
e.g. http://192.168.0.1:82

http://publicip:port for internet use e.g. http://212.137.22.14:82
http://domainname:port advanced option - if you have a 

DNS
e.g. 
http://vrs.mycompany.com:82 

You need to make sure your firewall is not blocking the port (default port 82). Refer to your firewall 
settings to check the correct TCP/IP port is opened.

Speak to your network administrator about any networking problems you have. They can usually 
quickly fix routing or firewall problems.
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IVM Application Interface - Setup a Remote Server 
System

IVM can operate remotely. At regular intervals IVM can check a server for any updates and, if 
the file has been changed, automatically load the updates. The updates can include changes 
to the OGMs, Mailboxes, System Prompts or Settings.

This can be used in a single IVM system (for example where you want to setup and test the 
IVM program in your office but where the active IVM runs on a computer in the Telephone 
Room in the basement). Or it can be used by voice prompt studios and telephone system 
consultants who offer system updates for any number of remote customers. A single Internet 
server setup can serve an almost unlimited number of remote systems.

To setup a remote update server system, you must have a good understanding of computers, 
networks and the Internet (including FTP client software like Fling available at 
www.nchsoftware.com/ftp

). 

Basics 

All updates are with IVR Program Files. For more information about saving IVR Program Files 
see Loading or Saving IVR Program Files . 

File Names. To reduce the chance of errors the file the remote IVM loads has an implicit name 
based on the registration ID of the remote IVM. If you are testing IVM and have not yet 
registered, this is 0. The file name is ivmX.ivr where 'X' is the ID number. For example, if your 
registration ID for the remote IVM is 1078, the file name will be ivm1078.ivr. THIS IS CASE 
SENSITIVE. 

To setup the remote IVM. In the IVM applications go to File -> Load... -> Direct Remote 
Download. Here you need to point IVM to the remote ftp server (e.g. ftp.nch.com.au) or the 
LAN folder, tick the Automatic box and enter the interval for how frequently IVM should look for 
updates.

Internet FTP Servers 

To use this feature, you must have access to an FTP server that offers anonymous FTP 
access. You do not need to setup your own server. Most web hosting services include FTP. If 
you have a web site, there is a good chance you will already have access to an FTP server.

To upload files, you must have a FTP client. For example Fling or Classic FTP available at 
www.nchsoftware.com/ftp

. 

Before you proceed, you must know the exact folder into which you must load files so that they 
can be downloaded directly from the root directory of the anonymous ftp account. This is often 
something like /home/youraccount/www/anonftp on UNIX / LINUX web hosting servers. As a 
test, you must be able to download the file (say for ivm0.ivr) directly by typing 
ftp.yourdomain.com/ivm0.ivr into Internet Explorer.

The steps to update your remote IVM are:
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1. Save the IVR Program File. The file name must be ivmX.ivr where X is the remote IVM's 
registration ID (case sensitive). For unregistered remote IVMs use the file name ivm0.ivr.

2. Upload the file using your FTP application like Fling.
3. From the remote IVM, point it to your server using the Load / Direct Remote Download item 

of the File menu. For example, enter the server ftp.yourdomain.com. Also set the Automatic 
Interval. The recommended intervals are either 60 minutes (hourly) for fixed internet 
connections or 1440 minutes (daily) for dial up connections.

Local Area Networks  

If the remote IVM is running in the same building, you can use the LAN to update the IVM. This 
is usually faster than using the Internet.

Create a shared folder on the network server. Save the IVR Program File with the correct file 
name (see above) into that folder. Then point the remote IVM to the folder using the Download 
Remote Direct option. The recommended time for the Automatic Check Interval is 2 - 3 minutes.
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IVM Application Interface - OGM Manager

You can open the "OGM Manager" in a new window by clicking on the "OGM Manager" icon 
from the main IVM interface window. There are two views of all of the current OGMs in IVM, a 
List view, and a graphical view.

Graphical View 

The Graphical View attempts to display the OGMs in a logical order to help you visualize the 
call flow, using lines to connect OGMs . You can drag the OGMs around in this view to 
reposition them to improve the display. The more OGMs you have the more necessary this 
may be to get a good picture of what is happening. Note that you cannot directly edit the 
OGMs from this window, but you can double click on an OGM name to enter that OGM's 
properties. The "Refresh" control at the top of this view will once again attempt to put the 
OGMs in a logical order, so if you have done a large amount of rearranging yourself keep in 
mind that hitting refresh may undo all of that manual work, so use it with caution.

List View 

The List view in the OGM Manager Lists OGMs and Folders. This view is similar to the "OGM 
List" which can also be seen under the "IVR Profile" Tab of the web console. From this window 
you can edit or delete existing OGMs, as well as play the OGM audio, and create new OGMs 
and folders. See IVR Profile / OGM List for more information. 
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IVM Application Interface - Call Test Simulator

If you are making an interactive voice response system, with a large number of OGMs, you can 
use the Call Test Simulator to save you having to call your phone many times during the 
testing process.

To run the Call Test Simulator, select the "Call Test Simulator" item from the File menu.

The Call Simulator works almost exactly the same as a normal call. The call will always be 
treated as if the call was on line 1, the caller ID was 555-555-5555 with caller name "Simulator".

You may notice some differences in audio quality and response times (the Call Simulator is 
faster) when compared to a real call.

If you have problems attempting to record with the Call Simulator, you should check that you 
have a microphone plugged into the sound card of your computer and that the Sound Record 
Mixer has the microphone turned on.
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IVM Application Interface - Setup Wizard

The Setup Wizard will start immediately after installation. To start the wizard again at a later 
date it can be found in the File Menu from the IVM application.

Answering Machine (no PBX) 

The answering machine option works like an ordinary household answering machine. It will 
wait a specified number of rings (you can adjust this later) before answering a call. It can be 
used to handle a single mailbox, or allow a key press to access up to 10 mailboxes. For more 
information on this option, refer to the Answering Machine QuickStart guide. 

Voice Mail (with PBX) 

The voice mail option works like a voice mail service on a standard phone line. When a call is 
not answered the PBX (Axon is preferred) will transfer the call to a voice mail extension that 
will route the message to the correct mailbox based on the dialed number. It will also allow 
extensions on the PBX to call in and check their messages through the same extension. It can 
be used to handle any number of mailboxes and generally has one mailbox for each extension. 
For more information on this option, refer to the Voice Mail QuickStart guide. 

Automated Outbound Dialing 

IVM can also be used to make automated calls to a list of numbers. For more information on 
this option, refer to the Outbound QuickStart guide. 

Automated Call Attendant (with PBX) 

The automated call attendant works much like having a receptionist. When calling in, a user 
will be asked to dial the extension for the person they wish to contact and the incoming call is 
then transferred to that extension. This can be expanded to include business hours or location 
as well. For more information on this option, refer to the 
Automated Call Attendant QuickStart guide

. 

Information Line  

The information line can be used whenever you want to have a number of prerecorded 
messages that you would like to allow a person to listen to over the phone. When calling in, a 
user will be asked for the message number that they want to hear. This can be a real estate 
listing, automobile for sale, or anything else that you can imagine. Messages are managed 
through the same telephone interface meaning that you don't have to be next to your computer 
to make an update. For more information on this option, refer to the 
Information Line QuickStart guide

. 

Other (Complex IVR System) 

If none of the items before this fit what you are looking for, you may need the complex IVR 
system option. This will offer you several sample IVR solutions that can get you on the right 
track to building your own solution. For more information on this option, refer to the 
Complex IVR QuickStart guide
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IVM Web Interface Settings - System Setting 
Overview

See the following topics for information on the different systems settings that can be made 
from the "System Settings" tab of the IVM web interface.

●  General System Settings 
●  AutoHours Feature Settings 
●  Caller Blocking 
●  Call Transfer Settings 
●  Audio Recording Settings  
●  Line Playback Settings 
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IVM Web Interface Settings - General System Settings

Out-Going Message (Default Answering OGM) 

This is the default OGM that is used to answer calls. You can select the OGM using the pull 
down list.

The default OGM can be overridden by the AutoHours Settings and the Line Settings. 

If the OGM you want to select does not appear in the pull down list, go to the OGM Properties 
and make sure "List as answer OGM" is selected.

You can right click on this pull down list to access the OGM menu.

Turn off Answering  

Use this check to box to turn Off IVM. Untick to turn on.

This setting can be overridden by the AutoHours option and the OGM Properties for the 
answering OGM. 

You can also Turn IVM On and Off from the Application from the OGM menu or the shortcuts 
Ctrl+O and Ctrl+F for On and Off respectively.

Email Settings 

Click this button to set the email properties for all mailboxes with email delivery of voicemail 
messages

See Email Settings for more information. 

Answer Mode 

Answer calls after fixed number of rings 

Enter the number of rings to wait before IVM answers a call.

Tollsaver 

If Tollsaver is enabled; IVM will wait an additional 2 rings before answering if there are no new 
incoming messages. If there are new incoming-messages, IVM will answer at the standard 
number of rings. When using remote access you can use this feature so you will not pay for a 
call when there are no new messages if you hang-up before the call is answered.

Tollsaver Mailbox 

If Tollsaver is enabled you can either use it to check for messages in any mailbox or for a 
single mailbox. By selecting the single mailbox option the Tollsaver will only apply if there are 
new messages in that mailbox. The selected mailbox can either be based on the caller ID or 
set to a specific mailbox if necessary.
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Always be sure to save your changes with "Save Changes" button at the bottom of the page.
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IVM Web Interface Settings - Caller Blocking

Caller Blocking 

This feature is used to block callers from particular numbers (for example to block abusive 
callers) or even block callers with caller ID turned off.

This feature works even when IVM is in Off mode.

Note that the caller ID information is sent between the first and second rings on normal 
telephone lines, therefore you should answer after the second ring.

Block Numbers 

Enter the number that you want to block. To block more than one number list the numbers 
separated with a semicolon. You can also specify a number prefix - in which case IVM blocks 
all calls starting with that number.

Block Private or Unknown Numbers 

If this is ticked any call with caller ID turned off, blocked or not carried by the network will be 
blocked.

If call is blocked... Disconnect the call immediately 

If selected, IVM will pick up the call, play a short tone and then hang up on any blocked call.

If call is blocked... Answer this OGM 

If selected, IVM will answer the call with a special OGM which you can record. A typical 
example might be where you want to avoid private caller ID you might select an OGM with the 
message "For security reasons we cannot accept calls with caller ID turned off. Please call 
from another phone which supports caller ID".
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IVM Web Interface Settings - Audio Recording 
Settings

Default settings for any recordings that IVM will accept over the phone can be set under the 
"System Settings" tab in the web control. These "Default Recording Settings" of minimum and 
maximum recording times can be overridden for mailboxes from within the mailbox properties, 
otherwise all incoming messages will be limited to meet these requirements.

Note: In addition to these settings being the default for voicemail messages, they will also 
affect other recordings that are being called in to IVM, such as a mailbox user changing their 
voicemail greeting with remote telephone access, or if you have an IVR/OGM key response set 
to record a file.

Recording Settings 

Record Detect Level: This is for automatic voice activated recording and for end of call 
(silence) detection. If messages are not recorded fully, reduce this level (to say -36dB). If 
messages do not stop at the end of the call, increase this level (to say -15dB). 

Delete Messages: IVM automatically deletes in-coming messages after a set number of days. 
You can change the number of days using this setting. A value of 0 means the messages will 
never be automatically deleted. 

Format : Set the audio compression format for if you are sending messages as attachments to 
an email address, or uploading to an internet access web page, you can use a number of 
different codecs to compress the audio (reduce the file size and download time). The 
recommended format is GSM 6.10 or DSP GROUP TRUESPEECH. For others see our codecs 
information page www.nch.com.au/acm. 

Call Recording 

If you are looking to record telephone conversations, NCH Software now makes specialize 
programs to record phone calls. See www.nch.com.au/software/callrec for an overview of the 
different call recording options that are available, including VRS and TRx. 

The VRS Recording System can record all your phone calls automatically including multiple 
phone lines and/or extensions. 

While the TRx Personal Call Recorder can be used to manually record calls or parts of calls for 
single lines. 
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IVM Web Interface Settings - Line Playback Settings

These Settings can be found at the bottom of the "System Settings" tab in the web interface.

Here you can set the volume for the audio that IVM plays to callers.

In addition to volume control you can set the threshold for compression and turn on the audio 
high pass filter, to help compensate for the low fidelity over phone lines or through your modem.
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IVM Web Interface Settings - Plugins

An IVM Plugin is an external program that IVM can run to process or obtain data. For example, 
if you are making a interactive voice response system to tell the caller the current temperature, 
a plugin can be used to read from the hardware and return the temperature to IVM. A plugin 
could also be used to restart the computer, access a database, process credit card orders and 
more.

A number of useful plugins can be downloaded from www.nch.com.au/ivm/plugins.html. 

The "Plugins" tab in the web interface displays a list of the installed plugins.

Installing a Plugin 

Install a Plugin file by using the "Install New Plugin" button on the "Plugins" Tab of the web 
interface.

The 'Install New Plugin' Window will give you the option to install one of the plugins provided by 
NCH Software, which you can view at www.nch.com.au/ivm/plugins.html

OR you can upload your own plugin file. Plugins are usually provided as exe files (if you have 
an exe in a zip file you will need to extract the exe before trying to upload/install). 

Using a Plugin 

1.  Go to the "IVR Profile" Tab in the web interface.

2.  Select the OGM you want to have use the plugin to enter the "OGM Properties".

3.  Select the box in advanced settings that says, "Run another Executable or IVM Plugin".

4.  Click on the "Add Exe or Plugin" button.

5.  Select the "Run installed Plugin" radio button, and then you can choose the installed 
plugin from the drop down menu.

6.  If the plugin takes any arguments/inputs, enter them here being sure to get the order exact.

The plugin writer will prescribe the arguments that must be passed to the plugin (check for 
a text file in the zip file distribution). Take care to get the order exact. You can include any 
variable as an argument by circumfixing it with %. Variables can include the system 
variables %time%, %date%, %cid%, %callername%, %linenumber%, %linename%, 
%did%, %drn% and %callsequenceno%.

57

http://nch.com.au/ivm/plugins.html
http://nch.com.au/ivm/plugins.html


Information from the plugin is returned as one or more variables which you can use at any 
stage later in the call. Often one of these can determine which OGM to play next using the 
return variable name (circumfixed with % characters) as part of the OGM name to go to at 
the end of the current OGM. If it is a number, it can also be "Read" using the read number 
feature.

7.  Click "Save Changes" to add the plugin.

8.  If you want to run more than one plugin file in sequence you could then repeat steps 4-7. 
Otherwise Close this window to continue.

Multiple plugins can be run in sequence by adding them to the list in the Run Exe and 
Plugin Settings dialog box. Arguments returned in variables from one plugin can be passed 
to the next using %variablename% as the argument(s). The arrow key on the input screen 
can be used to arrange the order the plugins are run (from the top of the list to the bottom).

9.  Select "Is IVM Plugin Process" when you are back in the OGM Properties.

10.  Click "Save Changes" when you are done making changes to the OGM.

If you have difficulties using a plugin it may be helpful to look at the Most Recent Call Log for 
the line to view the exact data sent and returned from the plugin. 

Running other Programs or Files  

IVM can also run any other exe file (which in turn can be used to open almost all file types). 
However, if it is not a plugin, IVM will not be able to retrieve data from the process. To run or 
open a file that is not a plugin, untick the "Is IVM Plugin Process" option.

If the file is not a true IVM Plugin the "Is IVM Plugin Process" option must NOT be ticked.

Running a Plugin on Call Disconnect  

Sometimes you need to set your call so that if the call disconnects for any reason at any time 
later another plugin will be run. For example, this can be used to time call duration or to 
cleanup data relating to the call. To do this you set the variable "RunExeDisconnect".

For example if somewhere early during your call your run a plugin "startcalltimer.exe", that 
plugin can return a variable "RunExeDisconnect=[path].exe%20%-stop". Then whenever the 
call disconnects (however it disconnects) IVM will run that plugin.
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For more information about writing plugins (for programmers), please see the IVM Software 
Development Kit www.nch.com.au/ivm/sdk.html. 

59

http://nch.com.au/ivm/sdk.html


IVM Web Interface Settings - Log Files

You can open, print and delete log files from the "Logs" tab in the web interface.

Call Logs 

IVM logs every call (including those calls that are not answered). The log includes the date, 
time, caller ID (if supported by your hardware) and whether or not it was answered. Call logs 
are listed by date.

Most Recent Call Logs 

For every line, IVM makes a detailed log of the most recent call including call details, each 
OGM opened, any keys pressed by the caller or any commands pressed.

These can be very useful for diagnostics on complex IVR systems. If there is a mistake in your 
setup, by viewing the log after a call on the Call Test Simulator, you can see where things are 
going wrong. 

The Most Recent Call Logs will be named "Most Recent Call Line X" and can be viewed or 
printed from the "Logs" tab of the web interface.

System Logs  

The IVM System Logs include all information including the Call Log information, the Most 
Recent Call Log information any other system errors and messages.

Special Logs 

IVM can also create special logs of calls that use a particular OGM including any data that the 
caller may have entered. These can be used to count the callers (and caller IDs) of callers that 
select a particular option, or to record the data the caller has entered.

To create a Special Log, select the "Add Entry to Special Log" option on the Advanced Options 
section of the OGM Properties (Select the OGM from the list displayed under the "IVR Profile" 
tab). Enter the log name and the log line format. The log name is usually a name but can be a 
full file path. The log line format can include any data field variables (between two % 
characters). You can also use the call variables %time%, %date%, %cid%, %callername%, 
%linenumber%, %did%, %drn% and %linename%. If you are intending to import the log 
directly into a database or spreadsheet, we recommend you use commas to delimit each 
variable. (This is particularly useful when using IVM for customer surveys).

Modem Logs (Voice Modems only) 

These are not strictly IVM logs (they are created by TAPI's Unimodem V driver). They are 
useful when you think there might be something wrong with your voice modem. To view the 
modem log, select your Modem Properties from the Windows Control Panel and click View Log 
(under Diagnostics in Windows 2000/XP).
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IVR - Interactive Voice Response - Load/Save IVR 
Files

An Interactive Voice Response (IVR) Program is the system of all the (Out-Going Message) 
OGM "prompts" in a call flow with all the program information or properties. These can be 
saved as an IVR file for backup or for distribution by CD or the Internet. 

There are several options for loading and saving IVR files detailed below.

It is not necessary to save your IVR Program when you exit IVM, IVM will keep all changes you 
make automatically until you create a new IVR Program. But do make sure you save and back 
up your call flows before loading an ivr file because they may overwrite your current OGMs 
affecting the call flow.

Loading an IVR Program File 

To load an IVR Program file, select "Load New IVR Profile" on the "IVR Profile" tab of the web 
interface. From here you have the option to load one of the example ivr files provided by NCH, 
enter a path for an ivr file on the remote server, or browse your computer for an ivr file. When 
you have selected the profile you want to load click "Load IVR" to finish and return to the OGM 
list of the "IVR Profile" tab.

Note: Because update files can be saved in cumulative format (see below), you must take care 
not to accidentally load an early file. Cumulative update files must always be loaded in the 
order they are received.

Loading an IVR can overwrite your current call flow and you should backup your current call 
flow as an ivr program file prior to loading one of our example files if you think you will want to 
return to your current set up.

For more information about IVRs see Interactive Voice Response Systems. 

Load Example IVR 

We have provided several example IVR files that will give you an example of a basic setup for 
the particular task. These are examples are just starting points and you will still need to take 
the time to read more of the manual to be able to modify the IVR Program for your specific 
requirements, but hopefully they will help you along the way.

To Load one of these example files select "Load New IVR Profile" on the "IVR Profile" tab of 
the web interface and select the example ivr program from the drop down menu. Select 
Profiles to display a short description on what the program is designed to do.

Loading using a Direct Remote Download 

IVM can download files directly from a remote server. You can then set IVM to automatically 
check the server for updates at the predetermined interval. This is ideal if the person who 
sets-up and maintains the IVR Program is remote from where the IVM runs.
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You setup a Direct Remote Download directly from the IVM application. Go to File -> Load -> 
Direct Remote Download. If you have been given a remote server (e.g. ftp.nch.com.au) by the 
provider of your IVR service, select Load / Direct Remote Download, tick "Download using the 
Internet" and enter then server name. You should also tick "Automatic Regular Update Check".

For more information see Setting up a Remote Server System. 

Saving an IVR Program File  

To save an IVR Program file, select the Save IVR Program File item from the File menu.

Save OGMs 

This is the list of OGMs that you want to include in the IVR file. Tick the OGMs you want to be 
included in the file. You can also click the Save All button to select all OGMs.

Save OGMs - Remote Auto-Delete 

If this box is ticked, any OGMs which do not exist in the local IVM will be deleted on the remote 
IVM.

Save Mailbox Settings 

To include mailbox properties, tick the mailboxes in the "Save Mailboxes" list.

You can also tick the remote auto-delete box to delete any mailboxes on the remote IVM that 
do not exist on the local IVM.

By default, IVM only saves the mailbox properties and not the mailbox personal greetings. To 
save the mailbox greetings, tick the "Include Greeting(s)" box.

System Prompts 

If you have changed any of the IVM System Prompts, you can include those files in the IVR file 
by selecting them in the System Prompts list.

Settings 

You can change any of the remote IVM settings by including the settings in the IVR file. The 
settings are not documented in this manual. We suggest you open the settings.ini file in the 
C:\Documents and Settings\All Users\Application Data\NCH Swift Sound\IVM folder with 
notepad to view the possible settings.

Save Plugin(s) 

If you use plugins, they can be saved in the IVR. Select the exe files to be include using this list.

Set Audio Compression Format to Reduce File Size
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Audio recordings can be large which can make the IVR file large. If you want to reduce the file 
size you can use an audio compression codec.

Click on the "Set Audio Compression Format to Reduce File Size" button and select the format. 
The recommended format is GSM6.10. For others see our codecs information page 
www.nch.com.au/acm

. You should only use formats with 8000 sample rate. 

Notes 

The IVR Program Notes are notes about the IVR Program. You can edit the IVR Program 
Notes by selecting the Notes item on the File menu.

Tick the "Save IVR Program Notes" box to include the notes in the IVR file.

If you tick the "Popup IVR Notes when Loaded" box, the Notes will open when the file is 
loaded. This is useful where you want to encourage the remote user to read instructions.

Cumulative Update Files. Because audio files can be large, IVM lets you select what you want 
to save in the IVR Program. If you are using IVR Program files to distribute updates to a 
remote IVM, you can use this to send only the items that you have changed. When the remote 
IVM loads the file, it automatically collates the new material with the old. 

If you simply want to backup the complete IVR Program, just accept the defaults and click 
Save.

If you want to save only a cumulative update file, select only the modified OGMs from the lists 
provided before choosing save at the bottom of the window.

System Backup 

You can also do a complete system backup from the IVM Application. By Choosing File -> 
Save -> System Backup you will be choosing to save all of the system settings currently being 
used for IVM. This includes all of the audio, plugins, OGMs, system and mailbox settings. 
Everything is selected by default and you only need to choose a location and name the file; 
making this a quick and easy way to make a backup of the current system.
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IVR - Interactive Voice Response - IVR Profile / OGM 
List

The Out-Going Messages List can be viewed by selecting the "IVR Profile" tab in the web 
interface. This list is useful for managing all the OGMs in the system.

OGM Properties 

You can enter the OGM Properties by clicking on the OGM Name, or the edit icon for that row.

From within the OGM Properties, you can edit the Message Audio, Key Response Settings, 
Validity Checking

, and other Advanced OGM Options. 

Play  

Click "Play" to listen to the current Out-Going Message. To stop, click on the button again.

Add New OGM 

To create a new OGM, click on the "Add New OGM" button at the bottom of the list. This will 
open the OGM Properties window where you can name the OGM and set your options. Click 
Save Changes at the bottom of the Properties window when you are done.

To save you time when creating many similar OGMs, you can enter the properties of an OGM 
you have already created and select the "save As New OGM" check box at the bottom of the 
window before saving changes.

Delete  

Click on this button to delete the selected OGM.

Caution: You must manually change all references to this OGM before deleting the OGM to 
avoid breaking your IVR system.

Rename 

Click on this button to rename the selected OGM.

Caution: You must change manually all references to the OGM.

Report 

You will see the "Create Text Report" Option in the Dark Blue bar immediately below the tabs 
when you are in the IVR Profile Tab. Selecting Report creates and opens a document listing all 
the OGMs with their scripts, menus and other properties. This is very useful when working with 
very large IVR systems. The report can be saved, copied or printed.

List Ordering 
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By default the list of OGMs are listed in alphabetical order. Alternatively the list can be ordered 
in 'logical' order. This starts with the current answering OGM and lists then OGMs making an 
attempt to follow the menu structure. This logical order can sometimes make it easier to follow 
the system.
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IVR - Interactive Voice Response - OGM Properties

The OGM Properties for an Out-Going Message can be reached by going to the "IVR Profile" 
tab and click on the OGM by name or the edit icon.

Out-Going Messages are the building blocks of Interactive Voice Response Systems and when 
designing your call flow you will spend a lot of time editing OGMs to validate data, take input 
from users and direct calls. See the following topics for more information on the different 
properties OGM Settings and familiarize yourself with all the available settings.

●  Out-Going Message Audio 
●  Key Response Settings 
●  Active Commands  
●  Date-Time/CallerID Validity Checking  
●  Advanced OGM Options 
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IVR - Interactive Voice Response - OGM Message 
Audio

Out-Going Message Audio 

Play outgoing message 

Select this option to play the message associated with this OGM whenever this OGM is 
reached. You can adjust the message by clicking the Change Message Audio button.

Change Message Audio 

Click the Change Message Audio button to record the message, import a wav or mp3 file or to 
synthesize speech (text-to-speech).

To synthesize speech, you must have a speech engine installed. If a speech engine is not 
already installed with your version of Windows or if you want to add different voices, you can 
download one of the text-to-speech engines using the links at www.nch.com.au/speech (The 
Microsoft engine is free). 

Play external Wav/Mp3 file  

Select this option to play a message that is in a file on the computer's hard drive. This option is 
helpful if some OGMs shared an announcement or if your prompts will be regularly changed by 
another program.

Text-to-Speech voice synthesis of the script 

Select this option to synthesize your message at the time it is played. The IVM engine will 
generate the message based on the text in the "Script/Notes" text box. You can include 
variables (circumfixed with %) in the script if required (to read data returned from a plugin or 
earlier entry). (e.g. "You have entered %age% as your age. Is this correct?")

No outgoing message 

Select this option if you do not want to play a message for this OGM. This is most useful in IVR 
flows that process data using plugins and want to keep silent while processing 1 or more steps.

Script/Notes 

This field can be used for a number of purposes. It is recommended that you paste the 
message script into this field because this will make it much easier to see what each OGM 
asks.

Where you use the synthesize speech option; the synthesized speech text will automatically be 
placed in this field. If you are synthesizing speech on the fly this will contain the script that will 
be spoken.

Play Message 

Click on "Play Message" to listen to the current message. To stop, click the button again.
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End of the Message 

This box determines what IVM does after the Out-Going Message has played if there has been 
no other interaction from the caller.

Wait 

This is the silent wait time to wait for the caller to press keys. If the OGM asks the caller to 
leave a message, or is intended to sequence directly to another OGM without any other input 
from the caller, set the time to 0.

Repeat 

This is the number of times that the OGM is repeated if the user fails to enter anything.

If user input is expected the recommended value is 2. If no input is expected (e.g. the caller is 
asked to leave a message, or IVM sequences directly) then set the repeat value to 0.

On Completion 

This is the Active Command to execute at the end of the Out-Going Messages (after any 
required wait or repeats). 

If the OGM asks the caller to leave a message, the active command would be "Leave Message 
for Mailbox..." with the "Use personal greeting" option not selected.

If the OGM is a sequence OGM, the active command would be "Go to OGM...".

If the OGM really needs the caller to input information, the active command would most likely 
be "Goodbye (Polite Hang-up)" after a wait and number of repeats.

List as an Answer OGM 

To simplify the main window, and to reduce the likelihood of the user accidentally selecting the 
wrong default start OGM, you can select which OGMs will be listed as "Answering" OGM, that 
is, which OGMs can be used as the very first OGM at the start of the call.

If an OGM is not suitable to be the first OGM a caller hears, untick the "List as an Answer 
OGM" box.

See Also:  

Key Response Settings 

Active Commands  

Date-Time/CallerID Validity Checking  
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Advanced OGM Options 
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IVR - Interactive Voice Response - Key Response 
Settings

IVM has 2 key response modes - a single digit menu option and data entry for 1 or more digits 
(usually followed by the # key).

Select which mode you want to use and the set-up options for that mode by going to the "OGM 
Properties." These can be reached by selecting the Out-Going Message from The list under 
the "IVR Profile" Tab on the web interface. Use the radio button under Key Response settings 
to select the mode, and not how the available options change to match the selected option. 

Menu (single key press)  

A menu option is an option that a caller can select by pressing a key on their telephone 
keypad. When they press the key, IVM executes an Active Command. For example, "To hear 
our opening hours, press 1...". 

For each telephone key that the caller could press ('0' to '9', '*' and '#'), there is a drop down 
menu that allows you to select the Active Command that IVM should execute when that key is 
pressed. If you do not want to assign an option to a particular key, select either the "No 
Response" or "Invalid Option" active commands. For more information, please see: 
Active Commands

. 

Data Entry (variable) 

IVM can accept multiple digit data from the caller. This is useful for passwords, order taking, 
customer surveys, taking credit card numbers etc. Data entry will also need to be used if you 
want to offer the caller more than 10 Mailboxes.

When this option is selected the caller can enter a number (1 to 16 digits) followed by the # 
key. The number is then validated and then stored in a variable which can then be used later in 
the call. The number that the caller enters is stored with a variable name. Each number that 
the caller enters must be given a different name so that the information can be accessed later.

When the caller has entered the maximum number of digits or the caller presses the # key the 
"Press '#'" active command is executed,  so to use data entry, you must select a valid 
Active Command

 for "# or End."  

If you need to allow the # key during data entry (and to stop it being used as the 
data-entry-terminator) you can tick the option 'Allow # in data entry'. Then data entry is only 
terminated by the maximum number of digits being reached and if # is pushed it becomes part 
of the entered data.

Selecting the "Force '#' key to complete data entry" option will require the user to enter '#' to 
complete data whether the maximum length is reached or not. This can be helpful in making 
sure keys did not register twice.

Before executing the active command, IVM can validate the variable using a number range or 
a list of valid (or invalid) numbers (for example to check an access code). If this test fails, IVM 
says "that is not a valid number" and replays the OGM.
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The variables can be used at any point later in the call in a number of ways. Generally, 
anywhere you are able to enter text in an active command (e.g. OGM, Mailbox, Logfile, 
Transfer Number) you can include the variable by circumfixing the variable with two % 
characters. For example, if you prompt the caller to enter a number which you give the variable 
name "transferext", you can use "888%transferext%" as the transfer number (assuming 888 
was a prefix you wanted). If the user entered 123, the transfer number used would be "888123".

Similarly you could use the variable in the %name% form as part of an OGM name, Mailbox 
name, Play file name, Record file name and as a parameter to a plugin call.

You can also create a special log file of the data the caller has entered. This is useful for 
surveys, order taking, credit card payments and so on. You can create the log file with comma 
delimited fields which can be imported directly into a database. Variables can also be "read" 
out to the caller. For more information, please see Advanced OGM Properties. 

Variables can also be sent to and returned by IVM Plugins for more information, please see 
Using IVM Plugins

. 

The variables %time%, %date%, %cid%, %callername%, %linenumber%, %linename%, 
%did%, %drn% and %callsequenceno% are set automatically by IVM.

You can also set 'global' variables. By global we mean it applies to all lines (if set on one call it 
will apply to all). Set global variables under the Advanced portion of OGM Properties. You can 
also set them from other programs using the Command Line Arguments. 

Note: by convention the '*' key is usually used for Mailbox Access Control (on an answering 
OGM), otherwise it should be set to "Go to..." the previous OGM or to "Repeat OGM". The 
press '#' key is usually reserved for data entry or otherwise "No Response". Please also see 
ISO/IEC 13714 www.nch.com.au/ivm/iso13714.html

 which is the international standard for 
interactive voice response systems. 

See Also:  

Out-Going Message Audio 

Active Commands  

Date-Time/CallerID Validity Checking  

Advanced OGM Options 
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IVR - Interactive Voice Response - Active Commands

Active Commands are the commands that IVM can execute when the caller presses a key, at 
the end of an Out-Going Message or when a transfer fails.

No Response  

If this command is selected IVM does nothing when the caller presses the key. This option can 
only be used in a menu.

Invalid Option 

If this command is selected IVM says "that is not a valid option" then replays the OGM. This 
option can only be used in a menu.

Go to OGM...  

If this command is selected IVM opens to another OGM. This command is essential for multiple 
OGM interactive voice response setup as it lets the caller hear a sub-menu by pressing a key 
or to sequence OGMs by selecting "Go to OGM..." as the active command for the End of the 
Message.

Example: In your Answering OGM say "If you know the name of the person you want to speak 
to, please press 1. Otherwise, for s...". Create another OGM which says "For Joe Smith, press 
1. For Jane Doe, press 2...". On the Key Response Menu of the first Answering OGM select 
"Go to OGM..." in the pull down list next to "Press '1'". 

The OGM name to go to can include data-entry variable names circumfixed with the % 
character.

If you are using multiple level folders you can specify OGM names with folders. For example 
"MyMenus\StartOGM" would specify an OGM in the StartOGM folder. (You must have created 
the folder using the OGM Manager first). You can also specify relative directories like ".." for 
the parent folder or "." for the current folder (e.g. "..\MyOtherFolder\StartOGM").

Leave Message for Mailbox... 

If this command is selected the caller can record a message for the selected Mailbox.

You can select whether IVM should play the Mailbox personal greeting before recording the 
message. This depends on the context. Generally with menu options or transfer fail you would 
want the personal message whereas with end of OGM you would not.

Example: "To leave a message for our technical support department, please press 6". Create a 
new Mailbox called "Support" which could be set to email the message to 
support@yourdomain.com. Select "Leave Message for Mailbox... Support" as the OGM 
Properties Key Response Menu press '6' option. 

The mailbox name can include data-entry variable names circumfixed with the % character 
(often used were the PBX sends the extension number as in-band DTMF).
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If the mailbox does not exist with that name and the Validate Extension Exists option 
(described below) is not selected it is created with all of the mailbox settings set to their default 
values.

If you have the option 'Use mailbox special menu' ticked then while the caller is recording a 
message they can press the # key to change their message. You can change the text to 
"...once you have finished recording press #". When they press # they will then be offered the 
menu option "1 to record again, 2 to to listen or 9 to end the call".

If you have the option 'Use OGM menu for any other keys' ticked then all (other) menu key 
options are governed by the previous OGM menu properties.

If you have the option 'Validate Extension Exists' ticked then the OGM will only record a 
message if the mailbox actually exists. This can be useful in cases where a variable is 
collected for the mailbox that is used for recording. So if the mailbox was set to '%extno%' and 
mailboxes 101-110 exist currently, then a value of 103 for extno would allow recording of a 
message, but a value of 999 for extno would not as long as the Validate Extension Exists 
option is selected.

Play Wav/MP3 File... 

If this command is selected IVM will play the selected wav or mp3 file. When the playback is 
complete, the OGM Message will be replayed. IVM supports most wav files and mp3.

Example: In your Out-Going Message say "To hear our contact details or our office hours, 
please press 1". On the Key Response Menu of the OGM select "Play Wav/Mp3 File..." in the 
pull down list next to "Press '1'". When you select the option, you will be able to browse to 
select a wav file which could be a recording: "Our address is... Our Fax number is... Our email 
address is... Our office hours are... ". (You could do exactly the same thing by creating another 
OGM but the play option is sometimes simpler). 

Note: There are times when it might be preferable to create a new OGM with the audio file and 
use the "Go to OGM" command instead of the "Play" command because then the audio can 
have its own menu options.

The play file name can include data-entry variable names circumfixed with the % character.

Record Wav File... 

If this command is selected IVM will record the selected audio file.

Note: To record simple messages you should consider creating a Mailbox and use the "Leave 
Message for Mailbox..." option. Mailboxes can be much simpler than manually recording files 
using the Record Wav file command.

This option can be used to let the user record the audio for other OGMs. For example, if you 
have an sports results line, this feature can be used to let the reporter (after entering an access 
code) record the updated results.

The record file name can include data-entry variable names circumfixed with the % character. 
To ensure that a different file is used for each call, use the variable %callsequenceno% as part 
of the record file name. The %callsequenceno% is a unique number for each call.
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The maximum record time and silence detect time must also be specified. If the maximum time 
is reached or silence is detected, the "After autostop" command will be executed. The 
minimum silence detect time is 1 second (0:00:01.0) which can be useful when prompting the 
caller for a sequence of very short statements (e.g. callers name).

If you have problems with silence detection when recording, you may need to adjust the 
Record Detect Level from Settings.

An advanced option is the "Append to end of previous recording" option. When this is ticked, 
the recording is joined to the file end. This can be useful when you want to prompt the caller for 
many items (e.g. name, address etc.) but have the recording as a single file.

Rewind/Fast-forward  

If this command is selected during playback (of the OGM or an external wav file), playback will 
skip forward or back a predetermined time. Negative values are rewind and positive are 
forward. Times are entered under in the format [-]h:mm:ss.s. For example rewind 5 seconds is 
-0:00:05.0.

Pause / Resume Playback 

When this command is selected during playback, playback is paused until it is selected again. 
You also specify a maximum pause time (default 60s). After this time playback is resumed 
automatically. Do not select too long periods because if the caller hangs-up while in pause and 
if the end-of-call tone is not detected the line will be kept off-hook.

Transfer to...  

For more information about these options, please see: Transferring Calls. 

Dial... 

When the Dial active command is executed, IVM dials the entered DTMF digits including 
hook-flashes ('!') or pauses (','). When dialing is complete IVM executes the "Then" command 
selected using the Dial "Details".

Access Mailbox Control 

If this command is selected the caller will then be asked to enter their access code to check 
mailbox messages. This command is usually selected as the press '*' option for the answering 
OGM.

Repeat OGM 

If this command is selected the OGM is repeated. Any data entry is also cleared.

Goodbye (Polite Hang-up) 

If this command is selected, IVM says "goodbye" then hangs-up.

Hang-up (Immediately) 

If this command is selected, the call is hung-up immediately.
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See Also:  

Out-Going Message Audio 

Key Response Settings 

Date-Time/CallerID Validity Checking  

Advanced OGM Options 
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IVR - Interactive Voice Response - Transferring Calls

VoIP Transferring 

IVM can transfer calls using VoIP. For VoIP lines it is just a matter of selecting 'Transfer' in the 
OGM Properties.

Note that only Blind Transfer is supported for VoIP lines.

IVM cannot directly transfer between VoIP and conventional telephone lines without some form 
of VoIP to PSTN gateway, such as an FXO Adapter or a VoIP gateway provider . 

Transferring on PSTN lines 

If your telephone company or PBX offers the facility to transfer calls from a normal phone or 
extension, IVM will be able to transfer calls by dialing the appropriate sequences. The call 
transfer feature may be branded under trade names by your telephone company (e.g. Telstra's 
"Business Links" service). If your telephone company does not offer an effective transfer 
feature, you might be able to use a conference call feature to "simulate" call transfers with IVM 
(see below).

Before you can setup IVM to do this, you must understand exactly how to transfer a call using 
an ordinary telephone handset. It is important that you refer to the documentation of your PBX 
or of the transfer feature of your phone company. The most common system is to press the 
(hook) flash button to initiate the transfer ("!"), wait for the dial tone (",,,"), dial the number then 
either hang-up to complete the transfer or press flash again ("!") to retrieve the call.

Overview (How IVM Transfers Calls) 

The only connection between IVM and the telephone system is a simple phone line. The only 
signals IVM can use to transfer calls is dialed digits, a hook-flash ('!') or pauses.

To transfer calls, IVM follows the sequence (as entered using the Transfer tab of Settings) that 
a person would need to do using a regular phone. (A regular phone is not the same as phone 
system handsets that are specially wired to the phone system).

Most problems arise when the sequence has not been properly entered (or understood) or 
where the voice modem or telephony device does not handle hook-flashes correctly (see 
below). Use the Most Recent Call Log for the line to check IVM is doing what you think it ought 
to do. 

Note: this discussion relates just to real call transfers. VoIP blind transfers are easy and 
automatic.

Blind Transfer 

A blind transfer is a transfer where IVM simply hangs up after making the transfer without 
waiting to confirm that the transfer was accepted.
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Note: You cannot simulate a blind transfer with a conference call feature (see "simulating a 
confirmed transfer with a conference call" below).

Note: Blind Transfer is currently the only method supported for VoIP lines. 

Confirmed Transfer 

With a confirmed transfer, the person to whom the call is transferred is given an option to 
accept or reject the call. If the call is rejected or is not answered, the call is brought back to 
IVM. If a call is brought back, IVM will execute the transfer fail active command.

With a confirmed transfer you can set the number of times that the prompt is repeated before 
fail (the default is 7). You can use this to determine the time before fail. However, you must 
note that the number you enter is not seconds but the prompt repeat count.

Answer Detect Transfer 

When this option is selected, IVM initiates the transfer and then waits for the call to be 
answered. If the call is answered it plays the answering party a short tone then completes the 
connection. If the call is not answered, the IVM rejects the transfer.

For this to work well the "Answer Detect Settings" must be setup. See Outbound Autodial Calls 
for more information about this. 

Transfer Settings 

While the actual transfer number is part of the active command details, the digits to be dialed 
before and after the transfer number to initiate or complete the transfer must be setup using 
the Transfer tab of Settings.

The (hook) flash is represented by the '!' character in dial strings. A pause is represented by a 
','. We recommend that you always add a pause after a flash when you expect to dial further 
digits (i.e. '!,') to give time for the dial tone to come on.

Simulating a confirmed transfer with a conference call feature 

If your telephone company or PBX does not support call transfers but does support a 
conference call, IVM can use this feature to "simulate" a transfer. When you tick the "Simulate 
call transfers as a conference call", IVM will run through the normal steps to setup a 
conference call (thinking it is transferring the call) and then stay online for the call duration. 
(Note: Your phone line will be busy for the call duration).

This option is usually only effective with confirmed transfers not blind transfers.
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IVR - Interactive Voice Response - Voice Commands

Enable Voice Recognition 

By selecting this option you enable the current OGM to use speech recognition for input. 
Speech recognition is an expensive process and if many lines are recognizing simultaneously 
it may slow your computer down significantly. Be aware that you may need a more powerful 
machine to run several speech enabled lines at once.

Mapping Words 

IVM enables speech commands by mapping a specific word to a key press or series of key 
presses. When a word is recognized, IVM will treat it as if the series of key presses came in 
through DTMF presses. Multiple words can be mapped to a single key press, but a single word 
(or variations like "no", "nope", "never") should always be mapped to the same key press for an 
OGM.

For instance, if you had key press 1 mapped to your sales OGM, you may want to map the 
words "sales", "one", and "purchase" to key press 1. If you are adding voice commands to an 
extension dialing OGM where 101 was John's extension you could map "John" to "101". For 
the extension dialing example you could also map "one" to 1 and "zero" to 0, allowing the user 
to say "one zero one" to reach John as well. When mapping words you should try to include 
subtle variations like "oh" to zero so that a caller saying "one oh one" would also be able to 
reach the correct extension.

Launch Voice Command Tester 

The Voice Command Tester will allow you to validate your speech recognition grammar by 
speaking through a microphone. As words are recognized the dialog will show the word, the 
key presses it would map to, and the time at which the word was recognized (in case you are 
testing for repeated words like "one one one").

Notes:  

●  You will need to enable speech recognition from the General Settings tab of the Options 
dialog before voice commands will work. 

● The line that the call is taken on needs to correctly support recording of incoming audio for 
this to work. This means that the outgoing prompt cannot be audible to the incoming line. 
VoIP calls should always work correctly, and the Call Simulator will work as long as you are 
not using a microphone and speakers. TAPI modems and CAHTA devices may work if set 
up correctly (this may mean changing some settings on the devices drivers or 
configuration, see your devices manual for more information on how to adjust these 
settings). You can notice when a recording is playing the outgoing audio because the OGM 
will react to its own prompts. For example, the OGM might say "Press or say one to..." and 
recognize the word "one" without the caller speaking. This is an issue with the device (or its 
configuration) and not the IVM engine.

● If you are having trouble with voice commands, make sure that you can navigate your 
OGMs using the key presses correctly. It may be an issue with your OGMs Key Response 
configuration rather than speech recognition problems that are causing your issue.
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IVR - Interactive Voice Response - 
Date-Time/CallerID Validity Checking

Validity checking options can be found in the "OGM Properties." Click on the name or edit icon 
for the outgoing message you want to add validity checking to from the "OGM List" which is 
displayed under the "IVR Profile" tab on the web interface.

Date-Time Validity Checking 

Use this option to change the way a call proceeds depending on the date, time or week day.

This can be used to have different call paths for business hours, to have particular OGMs 
scheduled to commence or expire on set dates (for example, for seasonal messages or to 
correspond with promotions) or many other date-time related functions.

Dates are entered in the format YYYY-MM-DD and times in HH:MM:SS.

You can also use the AutoHours Feature for a simple system wide solution to having a 
different IVR call flow for a specified days or times. 

Use Number ID Validity Checking 

Use this option to change the way a call proceeds depending on the Caller ID (the number of 
the caller), the Dialed ID* (the number that the caller dialed) or the Distinctive Ring Number** 
(DRN).

To use the caller number id, your telephony hardware (e.g. voice modem) must support caller 
ID (check its manual) and you should set IVM to answer after at least 2 rings.

This feature can be useful to detect which area the caller is calling from (based on the start 
numbers of the caller ID) and to change the OGM accordingly. This feature can also be used to 
"ban" certain numbers from the system.

Notes:

* Dialed Number ID is only available with special telephone networks and hardware. Consult a 
telecommunications expert for more information.

** More information about "Distinctive Ring Detection" can be found in 
Hardware/Device Line Properties

. 

Both date-time validity checking and caller ID validity checking occur before the OGM starts so 
you can skip through a whole chain of OGMs without the caller being aware of this. This is 
useful if you need more complex validity requirements, but take care to avoid circular loops!

See Also:  
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Out-Going Message Audio 

Key Response Settings 

Active Commands  

Advanced OGM Options 
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IVR - Interactive Voice Response - Advanced OGM 
Options

Read out number after OGM 

IVM can read out numbers from a variable that has been entered by the caller or returned from 
a plugin (e.g. database results). This can be used to confirm data entry (e.g. "the number you 
entered was...") or to return information to the caller (e.g. "your account balance is...").

To use this, tick the "Read Out Number" box and enter the variable name. The variable name 
must not  include the % characters. 

You can also select the way IVM reads numbers. For example if the number to read was 
"1234", "Digits" would be "one two three four", "Number" would be "one thousand two hundred 
thirty four", "Dollars & Cents" would be "twelve dollars thirty four cents" and "Dollars Whole" 
would be "one thousand two hundred thirty four dollars".

The number is read at the end of the OGM. Usually this OGM would then be chained onto a 
further OGM using the "Go To" active command for the End of Message.

Add entry to special log 

IVM can create special logs of calls that play a particular OGM, including any data that the 
caller may have entered. These can be used to count the callers (and caller IDs) of callers that 
select a particular option, or to record the data the caller has entered.

To create a Special Log, tick "Add Entry to Special Log". Enter the log file name and the log 
line format. The format can include any data field variables (between two % characters). You 
can also use the call variables %time%, %date%, %cid%, %callername%, %linenumber% and 
%linename%. If you are intending to import the log directly into a database or spreadsheet, we 
recommend you use commas to delimit each variable. (This is particularly useful when using 
IVM for customer surveys).

Go to the "Logs" tab in the web interface to open, print or delete logs.

Announce call through speakers 

If you tick this and click browse to locate a file on your hard drive, whenever the caller reaches 
the current OGM, the wav file will be played through the speakers.

Often this can be used to play a wav file which might be a message "Call for Joe Smith... 
Please pickup line...". In the interim you select OGM audio which would probably be on-hold 
music or messages. When Joe Smith picks up the call, he presses a key which would be set 
using the Key Response line to make IVM hang-up immediately. That way the caller thinks 
they have been transferred but it really has just been on the same line. If the call is not picked 
up after the duration of the OGM on-hold music or messages file, IVM could be set to take a 
message.

Set Variables 

When each OGM starts IVM can set variables which can be used later in the call (local call 
variables) or at any time in future (global variables).
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The set string needs to be in the form variable=data. For example language=french will mean 
later you can use %language% almost anywhere in call flow settings and French will be 
substituted. Optionally more variables can be set separating each with & (e.g. 
variable1=data&variable2=otherdata).

The local call variables apply to this call and last for the duration of the call only.

Global variables last forever (or until you set them to blank) and apply to other calls. They are 
one way something somebody does on one call can change other calls.

The other two common ways of setting local call variables are data entry and plugins. Global 
variables are commonly set or changed by other programs using an IVM command line option. 
See www.nch.com.au/ivm/sdk.html for more. 

Run Exe or Run IVM Plugin 

IVM can run an exe or plugin as the OGM starts. This can be used to run another program to 
open almost any file (a movie mpg for example), or an exe or plugin which could do almost 
anything on your computer.

For more information about running exes or plugins, please see the topic Using IVM Plugins. 

Tick this option then browse to the program you want to use. You can add command line 
arguments to the end of the exe if required. The command line arguments can include caller 
data entry variables, circumfixed with the % character or the call variables %time%, %date%, 
%cid%, %callername%, %linenumber% and %linename%.

IVM can also run special IVM Plugins - an external program that IVM can run to process or 
obtain data. For example, if you are making an interactive voice response system to tell the 
caller the current temperature, a plugin could be used to read from the hardware and return the 
temperature to IVM. A plugin could also be used to restart the computer, access a database, 
process credit card orders and more. For more information about using plugins, please see the 
topic Using IVM Plugins. 

If the exe is a plugin, tick "Is IVM Plugin Process". You must not tick "Is IVM Plugin Process" 
unless the process is a true plugin! 

See Also:  

Log Files 

Using IVM Plugins 

Out-Going Message Audio 

Key Response Settings 

Active Commands  
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Date-Time/CallerID Validity Checking  
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Mailboxes - General Mailbox Properties

Mailbox General Properties  

You can access the following options from the mailboxes tab on the web application by clicking 
on the name of the mailbox that you wish to view/edit, or clicking on the edit icon. You can also 
access the settings by double clicking the mailbox name in the main IVM window.

Remote Access 

Tick this box and enter an access code if you want to be able to dial into IVM and listen to 
messages by telephone or by internet using your web browser.

For more information about the telephone remote access feature, please see 
Remote Access by Telephone

. For more information about checking mailboxes by internet see 
Web Access

. 

Note: Your access code needs to be 4-9 digits long, and you no longer have to have a 
unique code each mailbox as of version 4.20. If you tick the "Read Time of Message" 
option, the caller will hear the time that the message was called when they use Remote 
Access.

Mailbox Message Notification 

These features are normally used with a PBX to dial a number to turn on or off a MWI 
(Message Waiting Indicator) (see Connecting IVM to a telephone key system or PBX). It 
can also be used to dial a pager number to set a pager message. 

These are not standard outbound calls and are not meant to be placed to an extension. Call 
strings will be in the format "XXXXX,YYYYY" where XXXXX is the number to dial and after 
the call is answered IVM will dial YYYYY to set or clear the MWI flag (or to send a numeric 
page to the pager that was dialed).

When a new message arrives, dial:  

This number will be called when there are new messages in the mailbox.

After a message is checked, dial: 
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This number will be called when a new messages is checked from mailbox. This feature is 
only applicable when calling in to check messages. It is not intended for when messages 
are checked from the IVM graphical or web interface.

Example: 

PBX MWI Dial-In Number: 999

PBX MWI Format: Extension*1# (turn on), Extension*0# (turn off)

Mailbox Extension: 101

When a new message arrives, dial: 999,101*1#

After a message is checked, dial: 999,101*0#

Message Delivery 

Send to Email  

If this option is selected IVM will automatically send the message, or a notification of 
receipt of the message, to an email address.

To receive messages by email tick the "Send to Email" box, enter your email address 
and tick "Send audio file as attachment". If you only want to receive notification of receipt 
of a message (not the actual message), untick the "Send audio file as attachment" box.

If you are sending messages by email over slow internet connections, you should 
consider setting the audio compression format to reduce file size. See Settings - Audio 
for more information about settings the compression codec. 

You can send emails to multiple addresses by listing them separated with commas. 
Additionally variables, normally retuned by a plugin, can also be used (e.g. 
%emailaddress%).

This option can be used to send email notifications by SMS or a paging service. You 
need to use an email->SMS gateway (e.g. www.kapow.co.uk). Change the subject and 
template text using the email settings as required by your email->SMS gateway. Of 
course, you should not attach audio to an SMS email!

Email (SMTP) settings are the same for all mailboxes, and can be set along with the 
default message and subject line through "email settings" under the system settings tab. 
See Email Settings for more information. 
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Individual mailbox users can view the (SMTP) settings but can only change the subject 
and message contents of the emails they receive. This can be accessed from the "Email 
Settings" link in the mailboxes table under the mailboxes tab. Save changes to the 
Mailbox properties to return to the list of mailboxes to ensure changes to the users email 
address and attachment settings are saved before going into the email settings to 
change the email subject or message.

If you have a speech-to-text engine installed (e.g. Dragon Naturally Speaking) IVM can 
be set to automatically transcribe the messages with the speech recognition technology. 
To enable this, tick the "use speech recognition" option and select the engine in the pull 
down list. Emails will then be sent with the transcription. Note that the default Microsoft 
engine is not good enough and that because almost all messages will be with 
"untrained" voices even with the best engines available today there will be many errors.

If you have problems with the send to email feature see Troubleshooting Problems for 
some solutions. 

Upload to Internet Webpage using FTP 

IVM can automatically create a web page on your web site where you can listen to your 
messages online.

To use this feature you must have a space on a web server which will be used for the 
web page. Most Internet Service Providers (ISPs) allow their customers to have some 
space to have their own web site free (usually subject to a maximum number of MB). If 
you do not know if your ISP offers the service, call your ISP and ask whether they offer 
that service.

IVM uploads the page (and the recordings) using FTP. To upload a file you need to know 
the ftp server name (e.g. ftp.yourdomain.com), your user name, your password and the 
directory into which you want to upload the page (e.g. /home/yourusername/www). If you 
do not know these, please contact your ISP.

Tick the "Upload to Internet Webpage using FTP" option and enter the ftp details.

The name of your page will be based on your mailbox name. It will be in lower case with 
all spaces replaced with '_' characters and with the '.html' suffix. For example, if the 
mailbox is called "Mailbox 1" the webpage to access will be "mailbox_1.html" on your 
website.

If you are accessing the page over slow internet connections, you should consider 
setting the audio compression format to reduce file size. See Settings - Audio for more 
information about settings the compression codec. 

You can apply a security password to the site if required. Speak to a web designer for 
more information.

Note: You must not have any other wav files in the same directory used by IVM because 
IVM will delete any unidentified wav files (it will think they are outdated messages).

Send to (Network) Folder  
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When this option is ticked, IVM copies the message (as a wav file) to any folder. This 
can be on the local computer or on the network. This option is useful if you want to 
collect voice mail over your computer network. Create (shared) folders for each voice 
mailbox. When IVM receives a message it will copy the wav file to that folder. The user 
can have a link on their desktop to that folder so they can check their messages at any 
time from their computer.

Forward to Telephone Number  

When this option is selected, IVM will automatically dial a phone number after it receives 
new messages in the mailbox and offer the option to listen to the message.

You can also set the number of times IVM will attempt to forward the message and the 
wait time between calls.

Enter the number to dial, followed by a comma followed by any DMTF digits to dial after 
the call is answered. You can use additional commas to add 500ms delay each comma.

If the "AutoAnswer" option is ticked, IVM will automatically detect when the call is 
answered and play the single message directly. This is useful if it is possible that a 
phone with an answering machine will answer the call. Even though the menu is not 
played at any time during the message the menu commands for delete and/or transfer 
message can be used (see Remote Access by Telephone ). 

IVM uses ring-tone and silence detection to tell if a call is answered in AutoAnswer 
mode. The timing settings can be adjusted using the Outbound Autodial Call Settings. 

The Forward to Telephone feature can also be used with some pager systems but 
remember to set number of attempts to 1.

Before IVM can forward messages by telephone at least one line must have "Allow 
outbound and message forward calls" selected in the telephony line properties.

Server Notifications  

Use Call Screening 

If you tick this box, you will be able to monitor the callers' messages as they are being 
recorded through your computer speakers.

To use call screening, you must also select the Call Screen Device and volume from 
Settings - Audio

. 

87

mailremotebyphone.html
outbound.html
settingsaudio.html


Sound beep through speakers when new messages 

When the "Sound beep through speakers when new messages" option is selected, IVM will 
play a short tone every 15 seconds when there are new messages in the mailbox. This is 
useful to notify you when there are new messages.

Mailbox Message Notification 

Mailbox Message Notifications are used to set MWI (Message Waiting Indicator) flags on 
standard PBX systems. These are not standard outbound calls and are not meant to be 
placed to an extension. It is assumed that these calls are always answered. Call strings will 
be in the format "XXXXX,YYYYY" where XXXXX is the number to dial and after the call is 
answered IVM will dial YYYYY to set or clear the MWI flag.

When a new message arrives, dial:  

This number will be called when there are new messages in the mailbox.

After a message is checked, dial: 

This number will be called when a new messages is checked from mailbox. This feature is 
only applicable when calling in to check messages. It is not intended for when messages 
are checked from the IVM graphical or web interface.

Example: 

PBX MWI Dial-In Number: 999

PBX MWI Format: Extension*1# (turn on), Extension*0# (turn off)

Mailbox Extension: 101

When a new message arrives, dial: 999,101*1#

After a message is checked, dial: 999,101*0#

Voice Mail length 
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IVM will treat any Voice Mail that is shorter than the set minimum length as being too short, 
and will delete it without any further action.

If someone tries to leave a message longer than maximum message length, they will be 
sent to the message options when the maximum is reached, giving them the options to 
listen to their message or record the message.

Use system default 

Use the system default. You can change the system default settings from the System 
Settings tab of the weblet or the Messages tab of the Settings dialog from the IVM 
application window.

Customized for the Mailbox  

Use this value for the minimum or maximum recording time for this Mailbox.

Mailbox Greeting 

Each mailbox can have a personal greeting that will be played immediately before the 
message is recorded only if the active command is set to play the personal greeting. When 
recording to a mailbox you can choose not to play the personal greeting when leaving a 
message (if, for instance, the OGM already does it's own greeting). The personal greeting 
for the mailbox will still be able to be modified since more than one OGM could transfer a 
call to the same mailbox.

Play Greeting  

Click on the play button to play the current mailbox greeting. Click on the button again to 
stop playback.

Change Greeting Audio 

Click on the Change Greeting Audio button to record a new greeting, import a wav or mp3 
file, synthesize speech (text-to-speech) or restore to the default greeting. Speech synthesis 
is currently only available from the UI and not from the weblet.

To synthesize speech, you must have a speech engine installed. If a speech engine is not 
already installed with your version of Windows or if you want to add different voices, you 
can download one of the text-to-speech engines using the links at www.nch.com.au/speech 
(The Microsoft engine is free). 

See also:

Email Settings 
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Remote Access by Phone 
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Mailboxes - Email Settings

Mailbox Email Template 

Email Settings can be opened by clicking on the "Email Settings..." button from Mailbox 
Properties or from Send Email.

Sending using a SMTP Server 

You must enter the SMTP mailhost used by your ISP for sending of mail (call them if you do 
not know it) and your email return address.

If when using SMTP you receive an error message it might be that your server requires an 
authenticated login (a username and password) to send email.

Send directly to other side (work as own SMTP Server)  

Email is sent directly by IVM using a simple internal SMTP server. 

Problems sending Email 

Email Template Text 

When IVM sends an email, the subject line and email body text are created from a template. 
You can modify this template as required. The variables %date%, %time%, %cid%, 
%callername%, %mailboxname%, %linenumber%, %linename% and %callsequenceno% can 
be included in the text in addition to any variables entered by the caller.

Attached is a message received in your voice mailbox by the IVM Telephone Attendant.

Date: %date%

Time: %time%

CID: %cid%

Caller: %callername%

Mailbox: %mailboxname%

Open the attachment to listen to the recording.
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Mailboxes - Remote Access by Phone

You can check your IVM messages in any Mailbox by dialing into IVM.

You must have your mailboxes named numerically (i.e. 101, 102, 103, etc. NOT Mailbox 1, 
Mailbox 2, etc.).

To start the setup process, your Mailbox must have the "Remote Access (check messages by 
telephone)" option selected in the mailbox properties and the access code entered. This can 
be found in the mailbox settings, from the mailboxes tab click on the mailbox name or edit icon 
for the mailbox to view or edit these properties.

Note: Your access code needs to be between 4 and 9 digits long, and no longer has to be 
unique for each mailbox, as of version 4.20.

You must also make sure the Answering IVR prompt/OGM has "Access Mailbox Control" as 
the key response option for "Press *". To do this select the IVR profiles tab in the IVM user 
interface, and double click the IVR/OGM profile that you are using. Then, in the OGM 
properties, scroll down to the "Key Response Settings" and make sure the * option has the 
proper response enabled. Click "Save Changes" at the bottom of the page to save and return 
to the profile list. 

To access your Mailbox, when the call is answered, press the * key. Then enter your mailbox 
number followed by the # key. When prompted, enter in your access code followed by the # 
key.

You will then be played any new messages. The options are:

1 . Play the Message Again 

2 . Keep the Message and Skip to Next 

3 . Transfer to another Mailbox (see below) 

5 . Delete Message 

8 . Enter Mailbox Setup 

9 . End the Call (Goodbye) 

*. Access Another Mailbox 

# . Keep the Message and Skip to Next 

If you press 8, you can enter Mailbox Setup to record your personal greeting. The Mailbox 
setup options are:

1 . Play Personal Greeting 
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2 . Record Personal Greeting 

5 . Stop (Play or Record) 

9 . End the Call (Goodbye) 

*. Another Mailbox 

# . Stop 

To transfer a message to another mailbox press 3  followed by the first few digits of the other 
mailboxes access code and then # . IVM transfers the message to the first mailbox starting with 
the specified digits. For example if mailbox 1111 has access code 101234 then pressing 3 
1111 # will transfer the current message to that mailbox. 
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Outbound IVR - Automated Outbound Calls

IVM can be used to make automated outbound calls. It will automatically dial numbers from a 
list, waits for the caller to answer then starts with an OGM message and follows a normal call 
flow.

Before IVM can make outbound calls at least one phone line (VoIP or PSTN) must have "Allow 
outbound and message forward calls" selected.

To setup outbound calls, go to the "Auto Dial" tab in the IVM Web Interface.

List of telephone numbers to dial  

Enter the list of numbers to dial separated with ';' semi-colons. Copy (Ctrl+C) and paste 
(Ctrl+V) functions also work in the numbers list.

Numbers will be removed from the list as they are called. If you want to use the same set of 
numbers again in future, enter a name for the list so you can load it again in the future by 
selecting 'Load Saved List' instead of 'Create New List'.

Out-Going Message (OMG) Call Flows 

You can select different OGMs to start with depending on whether the call is answered by a 
answering machine or by a real person.

●  OGM to start with if answered by a person

The selected OGM will be used if IVM determines that the call has been answered be a 
person. 

●  OGM to start with if answering machine

The selected OGM will be used if IVM determines that the call has been answered by an 
answering machine. 

●  OGM to start if call is not answered

An optional OGM may be started if the call is unanswered. Select "None" if no OGM is to 
be started for unanswered calls.

Note that this OGM will have limited functionality due to there not being any telephony line 
to interact with. 

The intention is therefore to allow actions such as writing to a special log or using a plugin 
to update a database record. 

Note: Answer Detection is not completely accurate so your system must be tolerant of this. 
Detection works by using the length of the voice after the call is answered. A longer 'message' 
indicates an answering machine while a short 'greeting' suggests a real person. This can be 
adjusted using the Call Answer Detect Settings . 

Number of attempts for each called number 
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IVM can be set to attempt to redial numbers that were not answered. It goes through the list 
once. At the end of the list, it repeats the list calling all numbers not answered.

Minimum interval between reattempted calls 

If a call to a particular number fails IVM limits the time before it will be attempted again. The 
time is in minutes, with the default being 30 minutes.

Make calls between times 

IVM can be set to only make calls between a fixed time of day (to stop calls late at night for 
example). Enter the start and end times. To allow calls 24 hours a day enter 00:00:00 to 
24:00:00.

Advanced Options 

Advanced users can append data to each number if required. For example if the number was 
5551234567&ogm=My+OGM&data=999 the call would answer using the OGM named "My 
OGM" and with the variable "data" set to "999". You can also set ogmanswer to specify the 
OGM to use if the call is answered by a person or ogmmachine if answered by an answering 
machine. 

For example: 5551234567&ogmanswer=OPerson&ogmmachine=OMachine 

You can specify alternate numbers separating each with a \ character. If the first number fails, 
when the call is reattempted IVM will use the next number. For example 5551111111\
5552222222\5553333333 will try those 3 numbers in turn. 

If you need IVM to just dial a some DTMF digits after answering and then disconnect again use 
the argument dialanddrop. For example, 5551234567&dialanddrop=890 will dial the number 
5551234567, wait for it to answer, dial the DTMF digits 890 then hang-up. The comma "," can 
be used to insert pauses. 

●  &ogm

OGM to use for this number 
●  &ogmanswer

OGM to use if this call is answered by a person 
●  &ogmmachine

OGM to use if this call is answered by an answering machine 
●  &dialanddrop

dial these digits after the call is answered 

If you need one call to initiate other outbound calls download and install the plugin outbound 
from www.nch.com.au/ivm/plugins.html. 

Other software can also initiate outbound calls (or add them to the list). See the IVM SDK 
about how to link your program to IVM: www.nch.com.au/ivm/sdk.html. 

General Tips for using Outbound Calls 
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Answer detection is never accurate because a computer cannot easily tell the difference 
between voice and some tones. When you design an outbound autodial system, you should 
make it tolerant of calls that are detected as being answered too early. For example, the initial 
OGM should be repeating and should ask the caller to acknowledge the call by pressing a key.

See also:

Call Answer Detect Settings  
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Outbound IVR - Answer Detection Settings

IVM includes a software detection system to attempt to accurately detect when a call has been 
answered. The default is set to work for as many different environments as possible, but it may 
need to be modified to work for specific systems. These settings can be found on the "Auto 
Dial" tab in the web interface.

Answer detection works by listening to the phone line and looking at the length of the voice 
after the call is answered. A longer 'message' indicates an answering machine has answered 
the call, while a short 'greeting' suggests a real person.

Because IVM can't be sure that the person who has answered the call has finished their 
sentence. It will wait for silence (usually about 2 seconds). This means there will always be a 
short delay after the person answers before the Outgoing Message will start. Also note that 
IVM can misdetect and answer due to messages on the line.

In all circumstances you should design your outbound menu structure to be tolerant of early 
detections, false detections and late detections.

Ringing silence detect time [ms] 

When IVM detects a ring tone it will wait longer before starting than after voice. This time must 
always be a little longer than the maximum time between ring tones in your country. In the USA 
/ Canada use 4100ms (the maximum time is 4000). In Europe and Australia you can reduce 
this to 3100.

Voice silence detect time [1000 - 4000ms]  

After voice is detected IVM waits for a silence gap before it begins. If this is too short IVM can 
begin between words. A reasonable time is usually 2000ms. Be careful if you expect many 
answering machines because answering machine message often have longer gaps.

Ringing or busy time out [10 - 50 secs]  

IVM will abort the call as being unanswered if it detects ringing or busy tone for longer than a 
predetermined time. A reasonable value is 15 seconds.

Answer detect fail time out [15 - 60 secs] 

IVM will abort all calls as being unanswered (including those with voice detected) after a 
maximum time without any silence detected. 30 seconds is a reasonable.

Assume answer machine if voice longer than [secs] 

If you want to play different messages to calls answered by answering machines, IVM can 
attempt to guess whether the voice is a real person or an answering machine based on the 
length of the greeting. A typical value might be 8 seconds. If it is longer than this an answering 
machine must be assumed.

If you expect many answering machines you should use a longer voice silence detect time 
because answering messages can often have longer gaps.
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Note that answering machine detection is never completely accurate. You should design you 
menu structure to be tolerate of misdetections.
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Sample IVR Programs - Real Estate Property Line

Property Information Line for Real Estate Agents

This example creates an information line that can be used by real estate agents. It plays 
information about a property based on a 'property number' entered by callers. This example 
could also be modified for any application where you want customers to dial in and listen to 
numbered recordings.

Setup  

1.  Load the "Real Estate Property Line"

From the web interface go to IVR Profile -> Load New IVR Profile. Select "Real Estate 
Information Line" from the drop down menu and click "Load" 

2.  You will be asked to provide a password for entering new properties.

See below for information on changing this code at a later date. 
3.  Record Property Descriptions (See Below). This must be done before the system can be 

used. 
4.  Use the Call Simulator  to test.

(The default answer OGM should be set to "Propline Start") 

Recording Property Descriptions 

1.  Call into the property line (this can be done using the Call Simulator). 
2. When the IVM answers, press the * button and then enter your password followed by #.
3. Enter the number of the file or 'property' you want to enter information for, followed by #.
4.  This takes you to 'Record Center' where you have the following options:

Press 1  to Record

Press 2  to Play the recording

Press 3  to Stop recording

Press * to enter another file number 

Deleting Property Descriptions 
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When you load the Property line example ivr program a folder named "Properties" in IVM 
system folder (e.g. C:\Documents and Settings\All Users\Application Data\NCH Swift 
Sound\IVM\Properties). Every Property Description created makes a .wav file that can be 
found in this folder. To delete a property you will need to delete the .wav file with the 
associated number of that property from this "Properties" folder.

Changing Out-Going Message Audio 

From the Web Interface go to the "IVR Profile" tab. Select the Out-Going Message that you 
want to change (click on either the OGM name or the edit icon). This will take you to the 
OGM Properties

 page, from here you have several options for changing the audio file, see 
Message Audio

 for more information. 

Changing Password  

Go to the OGM Properties for the "Propline Record Access" OGM. The 'password' is saved 
under the Key Response Options. Under "Enable Input Constraints" change the value 
stored in "Short Comma Delimited List" to the new password. Be sure to click "Save 
Changes" at the bottom of the page to save the new password. 

Setting Range of Valid Numbers 

Go to the OGM Properties for the "Propline Start" OGM. Under the Key Response Options 
tick the limit range of acceptable box and enter the minimum and maximum values. When 
you are finished click "Save Changes" at the bottom of the OGM Properties page. 
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Sample IVR Programs - Sending A Fax

Sample Fax-back IVR Program

This is a sample IVR Program for IVM to demonstrate how to setup IVM to allow your 
application to fax a document to a number provided by the caller.

Note: IVM requires separate modems for sending faxes and answering calls. 

Setup  

1. To use this example you need to have the Microsoft Fax system correctly setup. See your 
Windows Help documentation for more information about the Microsoft Fax system.

2.  Load the "Fax Back" Example IVR

From the web interface go to IVR Profile -> Load New IVR Profile. Select "Fax Back" from 
the drop down menu and click "Load"

Loading this example also installs the "FAX" plugin for you. See Plugins for more 
information on plugins. 

3.  You will be asked to select the file for 'fax-back'.

The file to fax is usually a tif file but it can be any other printable format. 
4.  Use the Call Simulator  to test.

(The default answer OGM should be set to "Get Fax Number") 

Changing Out-Going Message Audio 

From the Web Interface go to the "IVR Profile" tab. Select the Out-Going Message that you 
want to change (click on either the OGM name or the edit icon). This will take you to the 
OGM Properties

 page, from here you have several options for changing the audio file, see 
Message Audio

 for more information. 

Changing the Document to be Faxed 

1. From the Web Interface go to the "IVR Profile" tab.
2. Click on the "FaxBack" folder to see the FaxBack OGMs.
3.  Enter the OGM Properties for "Send Fax" OGM and go to the ‘Advanced Settings’. 
4. Click on "Plugin Settings" under "Run another Executable or IVM plugin" in the advanced 

settings.
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5. Click on the edit icon for the fax.exe plugin.
6. Change the second argument to be the full path of the file to be faxed, in quotes (e.g. 

"C:\fax.tif").
7. Click "Save Changes".
8. Close the "Plugin Settings" page.
9. Click "Save Changes" at the bottom of the OGM Properties for the "Send Fax" OGM.
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Sample IVR Programs - Sample Survey

Sample Survey IVR Program

This is a basic survey with three generic questions.

Answers to the survey questions will be stored in "Logs\SurveyResults.txt" file which can be 
accessed from the "Logs" tab of the IVM web interface.

Loading this ivr program will create a "Survey" directory in the IVM program folder (e.g. 
C:\Documents and Settings\All Users\Application Data\NCH Swift Sound\IVM\Survey). After 
the three questions the caller is given the option to leave a message with any further 
comments they would like to share; these comments will be saved in the "Survey" directory 
named using the following format, "[date]-VoiceNotes-[caller id].wav".

Changing Out-Going Message Audio 

From the Web Interface go to the "IVR Profile" tab. Select the Out-Going Message that you 
want to change (click on either the OGM name or the edit icon). This will take you to the 
OGM Properties

 page, from here you have several options for changing the audio file, see 
Message Audio

 for more information. 

Adding Questions 

You can make copies of Out-Going Messages that can then be individually edited, by 
selecting "Save as new OGM" at the bottom of the OGM Properties page before selecting 
"Save Changes". If you are adding a question be sure to change the "Go To OGM..." for the 
"End" Action in the Key Response Options of the previous question to point to your new 
question to add the new question to your call flow. Use the Call Simulator  to test your 
survey. 
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Sample IVR Programs - Account Payment with Credit 
Card

Simple Account Payment with Credit Card System

This is a sample IVR Program for IVM to demonstrate how to setup IVM to automate the 
payment of accounts by credit card.

When the call is answered the caller enters their Account Number, Credit Card Number, Credit 
Card Expiration Date and the Amount they wish to pay. IVM then reads the entered information 
back to the caller. If they accept the information, IVM logs the payment in a comma delimited 
log file "Logs\Payments.txt" which can be accessed from the "Logs" tab.

Setup  

1.  Load the "Credit Card Account Payment Example"

From the web interface go to IVR Profile -> Load New IVR Profile. Select "Credit Card 
Account Payment Example" from the drop down menu and click "Load" 

2.  Use the Call Simulator  to test 

Note: With this sample, IVM only takes the callers credit card details and logs them in a 
comma delimited file to be imported into your accounts system. If you require real time credit 
card processing, you would need to write a gateway plugin to connect to your bank. 

Limit the Account Number Range 

This can help reduce the chance of errors. Go to the OGM Properties for the "Enter CC 
Number" OGM inside the "CCPay" Folder on the OGM List. Under the Key Response Options 
tick the limit range of acceptable box and enter the minimum and maximum values. When you 
are finished click "Save Changes" at the bottom of the OGM Properties page. 
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Telephony Lines - Telephony List

This is the list of all the telephone lines (PSTN and VoIP) currently configured for use.

This list should include all voice modems or professional telephony devices, as well as all of 
the VoIP lines that you wish to use, and all sip based lines that you may use to connect to 
other software programs, such as AXON or Express Talk.

Properties

Click on the device name or edit icon to view and/or change the properties of the selected line 
device. 

Add 

Below the list of telephony lines that IVM currently has added are two buttons. "Add New VoIP 
Line" and "Add New Hardware Line." which will open VoIP Line Properties or 
Hardware/Device line properties

 for the new line respectively. 

Note: "Add New Hardware Line" option will only be available if IVM detects hardware that is not 
already added to the Telephony List.

See also:

VoIP Line Properties 

Hardware/Device line properties 
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Telephony Lines - Voice over IP (VoIP) Line 
Properties

To setup a VoIP phone line for IVM you need to know your server, username and password, 
these will be provided to you by your service provider.

If you haven't signed up for an account yet a list of recommended SIP gateway providers is 
available at www.nch.com.au/talk/sip.html. 

Add a VoIP telephone line to IVM by going to the "Telephony Lines" tab of the web interface 
and clicking the "Add New VoIP Line" Button. To make changes to a VoIP line you have 
already added you can click on the name of the VoIP line or the edit icon in the list of 
Telephony Lines.

SIP Settings  

VoIP Account Name 

This is the name of the VoIP account. This field will be passed on as part of the caller ID 
information when a call is made using this account.

Number of simultaneous lines allowed 

This defines how many instances of the VoIP Account you would like to be created.

Note that if the provider of your account only allows one instance to be configured then 
setting this number higher than "1" will be of no benefit. Check with your SIP provider for 
the number of simultaneous calls you can use with your account . If the account is an Axon 
extension it can be used as many times as desired. 

SIP Number (or User Name) 

This is the user name provided by the VoIP gateway service. In most cases it is the actual 
phone number assigned to you for this account.

Use a different user name for authorization 

This option allows a different username from the Sip Number (or User Name) used for 
the Sip line to be used to authenticate the connection to the Sip server. The default, 
without this option selected, is to use the Sip Number (or User Name) for the server 
authentication.

Password 

The password for your VoIP account.

Server (Proxy and Domain)  
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This is the IP address or domain name of the server through which your account is 
provided. If you were not given this information in an email or webpage, you must ask your 
provider what it is.

Outbound Server 

Some users may need to use an outbound proxy server to get SIP requests to work 
correctly through a firewall or with legacy equipment. These can include a simple SBC 
(Session Border Controller), a SIP enabled firewall router or even a media transcoder to 
allow connections to legacy VoIP equipment. If you are running a SIP application that 
connects to a SIP PBX on the local network (LAN), then you will not need to use an 
outbound server. If, however, you need to pass a request through a computer on the DMZ 
of your network (if you don't know what this is you probably don't need to do this), this is 
generally done to pass requests through the firewall through a single centralized gatekeeper 
program called an outbound proxy server - you may need to enable the outbound server 
option. Some SIP providers may also require a different outbound server on their network. 
This option can be used to enable that as well.

Local server example:  

In this case the Proxy Server would be "sip.mynet.com", and no outbound server would 
be needed.

Outbound server example: 
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In this case the Proxy Server would be "sip.server.com", and the outbound server would 
be "fwd.mynet.com".

Network Settings 

These settings relate to your computer's ability to make phone calls over a network or the 
Internet. Most of the options here are fairly advanced, so don't change them unless you 
understand them fully.

Local SIP port 

The UDP port on your computer that will be used to create a SIP signaling connection. If the 
port is in use then the software will find the next available port.

Local RTP port 

The UDP port on your computer that will be used to for the audio connection. If the port is in 
use then the software will find the next available port.

NOTE You must open both of the above local ports on your local computer's firewall. Your 
router should be able to handle opening its own ports automatically, but if it can't then you 
may need to setup port forwarding. 

Use UPnP to find external IP address 

Uses the Universal Plug 'n' Play (UPnP) protocol to determine your external IP address. It is 
a quick and easy way of having your router configure itself. Many routers have UPnP 
disabled by default so you might have to enable UPnP on the router first. Refer to your 
router documentation for instructions.

Some routers are unable to use UPnP at all and some older routers do not do it effectively. 
If you have one of these routers, enabling UPnP may cause problems with outbound dialing 
and with voicemail.

Note that if you are using Microsoft Internet Connection Sharing (ICS) over a LAN, you may 
need to enable UPnP in Windows. To do this, on the computer running Internet Connection 
Sharing select Start -> Settings -> Control Panel -> Network Connections and then right 
click on the Internet connection and select Properties. Go to the Advanced tab and check 
the option "Allow other network users to control or disable the shared Internet connection".

Use STUN servers to find external IP address and port 

Uses the "Simple Traversal of UDP protocol through NAT" technique to ask a server on the 
Internet if you are behind a NAT or firewall, and if so, what your external IP address is. The 
default STUN servers should only be changed if your SIP provider has given you a different 
STUN server to use.
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Use static IP address and static mapped ports (Advanced Option): This is where you can 
enter your external IP address and SIP/RTP ports if your computer, or the server computer 
on which your network connects to the Internet, is using a static IP address. If you choose 
to use this option then we recommend the SIP and RTP ports are set to 5060 and 8000 
respectively.

If you are having problems making phone conversations and suspect the issue is 
network-related, then click the "Run Network Setup Wizard" button in order to launch a 
wizard that will guide you through the network troubleshooting process.

Quality / Bandwidth 

These settings relate to the choice of codec when making a phone call. There is an inverse 
relationship between the quality of audio and the amount of bandwidth that will be required. 
If you want to keep your bandwidth down which can be useful for slow internet connection, 
the codec used will result in a lower quality audio. Alternatively if you are looking for higher 
quality audio you can select the codec for high quality audio which will require using more 
bandwidth.

General Line Settings 

Answer OGM 

By default, all lines answer starting with the default Out-Going Message (OGM) that is set in 
the General System Settings in the "System Settings" tab on the web interface. If you are 
running multiple lines, and want to override this default so different lines have different 
starting OGMs, use this drop down list to select the OGM that will override the default for 
this line. 

Answer Mode 

You can also override the default 'Answer Mode' that are set in the General System Settings
by selecting the 'Override Default Options' check box. These options allow you to set the 
number of rings or a tollsaver option for individual lines, changing the number of rings or the 
tollsaver options as appropriate. If at any time you wish to go back to using the default 
values simply uncheck the 'Override Default Options' box and of course click "save 
changes" at the bottom of the window. 

Disable Caller ID Flash for this line 

If you are running multiple lines, but want Caller ID Flash/Announcement on only some 
lines, you can use this check box to disable CID Flash on the line. For more information see 
Caller ID Blocking

. 

Allow outbound calls 
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By selecting 'Allow outbound and message forward calls on this line' IVM will use this line 
when making outbound or mailbox message forward calls. Normally all lines will have this 
selected. If you have multiple lines and one is a priority incoming line that you do not want 
to be busy you can turn off outbound calls on the line. You may also want to limit the lines 
that are used by the automated outbound dialer; when making outbound calls, IVM 
searches for a free line with outbound dialing enabled, searching through the lines in the 
order the lines were added.

For more information see Outbound Autodial Calls. Also see Forward to Telephone 
Number Message notification in General Mailbox Properties  

SIP Message Logging 

Log all SIP messages This will log all the SIP messaging data into a file. 

Log all RTP (audio) packets This will log all audio data that is sent and received. 

SIP and RTP data are both stored in the one file for convenience. Files are split up 
according to day in order to avoid creating large files. This option is used when you are 
experiencing difficulties with the software and need to either look at a SIP message log or 
need to send a log to NCH to assist problem resolution. This option should be left off unless 
needed, as it will write data to files which can potentially slow down the software. Once 
enabled, this option can only log future calls, it cannot log what has happened beforehand, 
so it must be enabled before running any call testing scenarios.

Logs can be viewed from the "Logs" tab. See IVM Log Files for more information. 
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Telephony Lines - Hardware / Telephony Device 
Properties

Telephone Line Hardware/Device Properties  

To add a Telephony hardware and Devices go to the "Telephony Lines" tab of the web 
interface. All Hardware already added will be in the list of telephony lines, these can be edited 
by clicking on the device name or their edit icon.

The "Add New Hardware Line" Button below the list of current telephony lines will only be 
available if IVM detects telephony hardware on the machine that has not already been added. 
When you click the "Add New Hardware Line" button it will fill in the new hardware device for 
you, or give you a dropdown menu of the available devices to add if more than one is found.

If you are attempting to add a hardware device and do not have "Add New Hardware Line" as 
an available option or do not see that device in the list of hardware devices then your TAPI 
drivers have either not been installed or have failed. For more information, please see: 
Telephony Hardware (TAPI and driver issues)

. If you are still having trouble getting IVM to 
recognize your device see www.nch.com.au/kb/10045.html  for troubleshooting. 

For more device information see:

●  Voice Modems and Telephony Devices: www.nch.com.au/ivm/modems.html 
●  Recommended Voice Modems: www.nch.com.au/kb/10063.html  
●  Telephony Hardware (TAPI and driver issues) 
●  www.nch.com.au/kb/10045.html  

General Line Settings 

Answer OGM 

By default, all lines answer starting with the default Out-Going Message (OGM) that is set in 
the General System Settings in the "System Settings" tab on the web interface. If you are 
running multiple lines, and want to override this default so different lines have different 
starting OGMs, use this drop down list to select the OGM that will override the default for 
this line. 

Answer Mode 

You can also override the default 'Answer Mode' that are set in the General System Settings
by selecting the 'Override Default Options' check box. These options allow you to set the 
number of rings or a tollsaver option for individual lines, changing the number of rings or the 
tollsaver options as appropriate. If at any time you wish to go back to using the default 
values simply uncheck the 'Override Default Options' box and of course click "save 
changes" at the bottom of the window. 
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Disable Caller ID Flash for this line 

If you are running multiple lines, but want Caller ID Flash/Announcement on only some 
lines, you can use this check box to disable CID Flash on the line. For more information see 
Caller ID Blocking

. 

Allow outbound calls 

By selecting 'Allow outbound and message forward calls on this line' IVM will use this line 
when making outbound or mailbox message forward calls. Normally all lines will have this 
selected. If you have multiple lines and one is a priority incoming line that you do not want 
to be busy you can turn off outbound calls on the line. You may also want to limit the lines 
that are used by the automated outbound dialer; when making outbound calls, IVM 
searches for a free line with outbound dialing enabled, searching through the lines in the 
order the lines were added.

For more information see Outbound Autodial Calls. Also see Forward to Telephone 
Number Message notification in General Mailbox Properties  

End-Of-Call Detection 

IVM uses the end-of-call tone detection from both the hardware and its internal software 
detection. The default settings usually work well but if you find that calls hang up 
unexpectedly (during playback or record) or you have good hardware and want to reduce 
call online times, open the End-of-Call Tone Detection Settings.

Enable end-of-call tone detection during playback. By default this is off to stop the out-going 
audio being mistaken for an end-of-call tone by cheaper voice modem circuits. If you have a 
professional telephony device and are playing long recordings you might try turning this on 
so that IVM will disconnect immediately if the caller hangs up during playback. Otherwise 
IVM waits to the end of playback. 

Enable software based end-of-call tone detection. By default this is on so IVM detects the 
end-of-call tone even when the hardware fails to detect it. This must be on if end-of-call tone 
detection during playback is off. 

Call Detection Timing  
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Most hardware takes a little time to detect end-of-call tones or DTMF tone presses. The 
end-of-call or key press will only be reported after it has been recorded. To compensate for 
this IVM rewinds the recording a preset time so that the end of the recording is more exact. 
Because different hardware has different timing you may need to adjust these for optimal 
performance.

End-Of-Call Detect Delay (ms) . This is the time that IVM trims a recording back after the 
end of call tone is detected. If you find your recordings are chopped off (at the end of a 
recording) reduce this time. If you find too much of the end-of-call tone is recorded, increase 
this time. (Note: if you find it is very long make sure you have enabled software end-of-call 
detection as described above). The default value is 4500. 

DTMF Tone Detect Delay (ms) . This is the time that IVM trims a recording back after a 
caller presses a key. If you find the recording is chopped off you can reduce this a little. 
Beware: a too short time can cause unpredictable results if a recording includes the DTMF 
tone itself because when that recording is replayed the tone will be redetected. The default 
value is 350ms. 

Distinctive Ring Detection 

On some phone lines it is possible to have different ring 'sounds' to differentiate between 
calls of different type (e.g. faxes or voice calls) or calls to different numbers (where different 
numbers are received on one line). IVM can use this to only answer particular calls or to 
play different messages to different callers.

Distinctive Ring is processed using a Distinctive Ring Number (DRN). This number is 
somewhat arbitrary (see below). It is used under "Use Number ID Validity Checking" on the 
Date-Time ID tab of OGM Properties to either move to a different OGM or to not allow (or 
answer).

Distinctive Ring Settings 

The Distinctive Ring Settings are on the Advanced Line Settings from the Devices tab of 
Settings.

Use hardware based distinctive ring: When selected the DRN is a number returned directly 
from the voice modem or telephony voice board. If the hardware supports distinctive ring 
detection we recommend that you use it. The problem is that many voice modems and 
telephony voice boards do not support distinctive ring and in that case you need to use 
software detection. 

Use maximum ring interval - software based ring detection: When this option is selected, 
IVM uses the maximum time between rings to calculate the DRN. If the maximum time is 
above the set time it will report a DRN of 1. If it is below it will report a DRN of 0. 

Setup Distinctive Ring Number (DRN) 
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The DRN is recorded on the Most Recent Call log. Before continuing setup call the line with 
one ring first, let it answer and then look at the Most Recent Call log. Record the DRN and 
time (ms). Then call the same line with a different ring type again letting it answer and then 
comparing the DRN and time on the most recent call log.

If the DRN number is different you can probably continue to use hardware based distinctive 
ring by changing the settings on the answering OGM as part of Validity Checking. 

If the DRN reported for the different calls is the same then your hardware probably does not 
support distinctive ring. In that case you must use software based distinctive ring detection. 
Compare the DRN ms times of the two calls. Select the "Use maximum ring interval" option 
(see above) and enter a time (in ms) that is exactly between the times reported by the 
different calls. When you next make calls, you will see the different DRNs on the Most 
Recent Call Log.

Fax Detect Options 

These options determine what IVM does when it detects an incoming fax.

Fax support is only available for TAPI type hardware telephony devices. Not all TAPI 
devices are support fax, check your device features.

TAPI Fax Mode Handoff  

If this option is selected, IVM performs a TAPI Mode Handoff so any other TAPI Fax 
Software running on the same computer can take control of the call. Unfortunately, no fax 
software on the market at the time of release of this software accepts a TAPI handoff 
correctly.

Turn On Fax Machine by Dialing Digits 

Many fax machines will let you activate them by dialing a digit or digits when you hear a fax 
tone. IVM can do exactly that when it detects a fax call. With the "Dial... then Hang Up" 
option, IVM can dial the digits to make your fax machine turn on and answer the call. Refer 
to the manual of your fax machine for more information.

For more information about Faxes and IVM, please see: Fax Support. 

See also:

TAPI and driver issues 

Fax Support 

114

ivrvaliditycheck.html
fax.html
hardware.html
fax.html


Telephony Lines - Telephony Hardware and Driver 
Issues (TAPI)

IVM uses the TAPI (Telephony Application Interface) standard to connect to a wide range of 
telephony hardware devices (including voice modems or professional telephony voice cards). 
Often when IVM does not work, it is because the hardware is not TAPI compliant or because 
there is some problem with the drivers or driver installation.

If the drivers are not working properly:

● There will be no device listed in the add device pull down list; or,
● IVM will not be able to detect and answer in-coming calls; or,
● IVM will not be able to play the out-going messages; or,
● IVM will not be able to record messages.

Customers frequently report that their modems are nearly working. Perhaps some key 
responses are not working, the audio quality is poor or there is an excessive delay in reaction 
time. These problems are related to modem performance and not to any setting in the IVM 
software. The wave drivers associated with the modem turn the modem into a "pseudo sound 
card" for the production and recording of sound and for the detection of DTMF tones. The IVM 
requires that information collected by the modem (DTMF responses and CID information) be 
supplied to the IVM via TAPI. Some modems will for instance supply their own software with 
CID information but will not supply the information via TAPI. They are not 100% TAPI 
compliant and are not completely compatible with the IVM.

Please refer to the notes below on Voice Modems and Professional Telephony Cards for some 
solutions if your device is not working.

For up-to-date information, please view www.nch.com.au/ivm/modems.html. 

You must be aware that we are unable to provide technical support for these problems. You 
should refer the problem to the manufacturer of your telephony card or modem. If you are a 
technical person, it can be useful view the modem logs to see where the problem occurs.

Voice Modems 

Voice Modems must be VOICE modems 

You must check that your modem is actually a voice modem. Refer to the modem 
documentation and specifications. Modems which are not voice modems cannot work with IVM.

Voice Modem Driver Installation - Remove unneeded/old modem drivers 

If you have upgraded your modem or installed additional modems without removing the 
unneeded drivers, Windows TAPI drivers might fail. If that is the case, the only solution is to 
uninstall all modems, and then reinstall your single modem.

Voice Modem Driver Updates 
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Some modems are distributed with the drivers supplied on the CD-ROM being only for the 
non-voice modem version or are otherwise defective. Some manufacturers have fixed this 
problem with updated drivers that you can download from their websites. If your modem is not 
working with IVM, check your modem manufacturer's website for an updated modem and wave 
driver.

There are update drivers for Zoom Voice Modems, USR (US Robotics) modems, Maestro 
Modems and many more. Visit the manufacturer's website to download the updated driver.

Voice Modem Plug & Play Problems 

Sometimes when a modem is first installed, plug & play detects and installs the drivers for the 
non-voice modem equivalent. The solution to this is to uninstall your modem and restart your 
computer, then when plug and play detects your modem again, manually select the modem 
(instead of using the automatic driver selection feature of plug and play).

Professional Telephony Cards 

Professional telephony cards tend to have much better audio quality and, once they have been 
correctly installed, work very reliably.

More information about Professional Telephony Cards is available at 
www.nch.com.au/hardware/telephony.html

. 

Music Telecom Cards 

Music Telecom cards are no longer recommended because they are defective.

See also:

My Modem or Telephony Board is not listed as a valid telephony device 
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Telephony Lines - Fax Support

Sending Faxes - Fax-Back Systems 

IVM can work as part of a fax back system to receive the caller's fax number and other 
information (e.g. document number) and then fax a document (a tif file) to the specified 
number. Similarly IVM can also use the fax plugin to fax call logs, information to you at a 
remote location.

To setup a faxback system, you will need to be confident with using both 
Key Response Settings

 and Plugins. 

The first step is to install the 'FAX' plugin from nch.com.au/ivm/plugins.html. This plugin uses 
Microsoft Fax which is supplied with Windows 2000/XP/Vista. For more information on plugins 
see IVM Plugins. 

Receiving Faxes 

When IVM detects an incoming fax, it can do one of two things:

1.   TAPI Fax Mode Handoff

If your fax software is TAPI based, IVM follows the correct TAPI prescribed call hand-off 
procedure so the call can be accepted by other fax software. 

2.   Fax Machines

If you run a fax machine on the same line, IVM can trigger your fax machine to turn on 
when IVM detects a fax tone. After your fax machine is turned on IVM hangs up. 

IVM turns on your fax machine using a dial sequence that it dials the moment it detects a 
fax tone. Refer to your fax machine manual. You will find that you can usually turn on the 
fax feature if you hear fax tones on the line by dialing digits. From the Telephony tab of 
Settings, select any "Hardware" type line, display the selected line's properties then select 
the Dial this number option on the "Options" tab and enter the digits that are required by 
your fax machine. 
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Screen References - Advanced Recording Options

Automatic Recording

The recording can be automatically started when either the Record Control dialog is opened or 
when the audio to be recorded reaches the threshold level. Additionally any quiet periods at 
the start and the end of the recording that is below the threshold level can be trimmed.

Auto Start Recording

The recording will automatically start when the Record Control dialog is opened, you will not 
need to select the record button.

Auto Trim Recording

Trim the recording to remove any quiet periods from the start and ending of the recording. Use 
the threshold slider to specify the cutoff level.Voice Activated Recording

Automatically start the recording when the audio level reaches the threshold.

Threshold:

Use the slider to set the threshold level for the recording. Used for both the auto trim and the 
voice activated start.
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Screen References - Digit Mapping

Advanced parsing PBX dial string 

Use the parsing string to define which digits are placed in to which variables. Each of the 
variables is given a number 1 to 9, use these numbers to mark which variable a digit location 
will be mapped in to. Any non-numeric character, eg X, indicates that the digit is to be ignored 
and not placed in to any variable. A parsing string like X111X222 will map the second to fourth 
digits to the first variable and the sixth to eighth digits to second variable.

For example using the pattern X111X222 and the entered number 12345678, first and fifth 
digits, "1" and "5", will be ignored, the digits "234" will be placed in to the first variable and the 
digits "678" will be placed in to the second variable. 
Variables 

Enter the names of the variables to take each set of digits. These variables may then be used 
by other OGMs. 
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Screen References - Call Answer Detect Settings

IVM includes a software detection system to attempt to accurately detect when a call has been 
answered. The system by default is set to work for as many different environments as possible, 
but it may need to be modified to work for specific systems. This can be done through the "Call 
Answer Detect Settings" dialog, access this through the "Settings" button in the "Outbound 
Autodial Calls" dialog. 

Note that because IVM will never be able to "understand" what is really happening, it can never 
be sure that the person who has answered the call has finished their sentence. It must wait for 
silence (usually about 2 seconds). This means there will always be a short delay after the 
person answers. Also note that IVM may misdetect and answer due to messages on the line. 

In all circumstances you should design your outbound menu structure to be tolerant of early 
detections, false detections and late detections. 

Ringing silence detect time [ms]

When IVM detects a ring tone it will wait longer before starting than after voice. This time must 
always be a little longer than the maximum time between ring tones in your country. In the USA 
/ Canada use 4100ms (the maximum time is 4000). In Europe and Australia you can reduce 
this to 3100. 

Voice silence detect time [1000 - 4000ms]

After voice is detected IVM waits for a silence gap before it begins. If this is too short IVM can 
begin between words. A reasonable time is usually 2000ms. Be careful if you expect many 
answering machines because answering machine message often have longer gaps. 

Ringing or busy time out [10 - 50 secs]

IVM will abort the call as being unanswered if it detects ringing or busy tone for longer than a 
predetermined time. A reasonable value is 15 seconds. 

Answer detect fail time out [15 - 60 secs]

IVM will abort all calls as being unanswered (including those with voice detected) after a 
maximum time without any silence detected. 30 seconds is a reasonable. 

Assume answer machine if voice longer than [secs]

If you want to play different messages to calls answered by answering machines, IVM can 
attempt to guess whether the voice is a real person or an answering machine based on the 
length of the greeting. A typical value might be 8 seconds. If it is longer than this an answering 
machine must be assumed. 

If you expect many answering machines you should use a longer voice silence detect time 
because answering messages can often have longer gaps. 

Note that answering machine detection is never 100% accurate. You should design you menu 
structure to be tolerate of misdetections. 
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Screen References - IVM Example IVR Files

Select any one of the IVM IVR examples to see some of the features of IVM.

● 10 Voice Mailboxes
● Basic Call Attendant (4 menu options with blind call transfer)
● Advanced Call Attendant (20 extensions, confirmed call transfer and voice mailboxes
● Real Estate Property Information Line

To see all example IVR files see IVM Example IVR Files.

For more information about IVRs see Creating More Complex Systems. 
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Screen References - Telephony ~ Other

Answer OGM

By default, all lines answer starting with the default OGM selected in the pull down list of the 
IVM main window. 

If you are running multiple lines, and want different lines to have different start OGMs (for 
example if different lines are doing different things), then you can override the default OGM 
using this pull down list. 

Use Default Out-Going Message

Select this option to use the default OGM selected in the pull down list of the IVM main 
window. 

Override Out-Going Message for this OGM

With VoIP lines you need to make sure that all outbound numbers (including mailbox forwards) 
will be correctly resolved on each line with this option ticked. 

When this option is ticked IVM will use this line when making outbound or mailbox message 
forward calls. Normally all lines should be ticked. If you have multiple lines and one is a priority 
incoming line that you do not want to be busy you can turn off outbound calls on the line. 

When making outbound calls, IVM searches for a free line in the order the lines are listed. If 
you want IVM to prefer particular lines for outbound calls you should remove all lines and add 
the in the preferred order. 

Answer Mode

These options allow you to set the number of rings or a tollsaver option for individual lines. 
Setting these options will override values set in the IVM Settings -> General tab -> 'Answer 
Mode' box. For more information on these settings, please refer here. 

By default IVM will apply the configuration in the Settings -> General tab -> 'Answer Mode' box 
for all telephone lines. If you want to change this for a specific line, go into the Settings -> 
Telephony tab and double-click on a line -> click on the 'Other' tab. Check the option 'Override 
Default Options', and then set either the number of rings or the tollsaver options as 
appropriate. If at any time you wish to go back to using the values set in the Setting -> General 
tab, simply uncheck the 'Override Default Options' option. 

General

Disable Caller ID Flash and Announcement for this line

If you are running multiple lines, but want Caller ID Flash/Announcement on only some lines, 
you can use this check box to disable CID Flash on the line. 

For more information about CID Flash see: Settings - Caller ID . 

Allow outbound and message forward calls on this line
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When this option is ticked IVM will use this line when making outbound or mailbox message 
forward calls. Normally all lines should be ticked. If you have multiple lines and one is a priority 
incoming line that you do not want to be busy you can turn off outbound calls on the line. 

When making outbound calls, IVM searches for a free line in the order the lines are listed. If 
you want IVM to prefer particular lines for outbound calls you should remove all lines and add 
the in the preferred order. 

For more information see Outbound Autodial Calls and 
Mailbox Properties - Message Forwarding

. 

Fax (when incoming fax tone is detected)

These options determine what IVM does when it detects an incoming fax. These settings are 
applied to all TAPI lines. 

Fax support is only available for TAPI type hardware telephony devices. 

TAPI Fax Mode handoff

If this option is selected, IVM performs a TAPI Mode Handoff so any other TAPI Fax Software 
running on the same computer can take control of the call. Unfortunately, no fax software on 
the market at the time of release of this software accepts a TAPI handoff correctly. 

Dial this number

Many fax machines will let you activate them by dialling a digit or digits when you hear a fax 
tone. IVM can do exactly that when it detects a fax call. With the "Dial... then Hang Up" option, 
IVM can dial the digits to make your fax machine turn on and answer the call. Refer to the 
manual of your fax machine for more information. 

For more information about Faxes and IVM, please see: Fax Support. 
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